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HOUDINI FOUNDATIONS

OVERVIEW
To create 3D animation and VFX for Film, TV, Video Games and VR, you need 
a combination of technical and creative skills. Houdini is the perfect tool for 
bringing these worlds together as you explore, create and refine your projects 
from concept to final sign off. 
While Houdini has a wide variety of tools designed for generating CG content, 
its node-based procedural workflow is what sets it apart. This approach makes 
it easier for you to create directable shots, explore multiple iterations and hit 
deadlines. As you learn Houdini, understanding how to work with these nodes 
and networks will be important to your success.

WHAT YOU WILL LEARN
This overview chapter contains general information about Houdini that will 
help you become familiar with important concepts and ideas. While you might 
not understand what it all means, this chapter will be a valuable reference point 
as you work through the foundation tutorials and build up your knowledge.

	� If you already work with 3D software then learning Houdini will be a 
transfer of existing skills. You will learn how to interactively build-up shots 
using the scene view and shelf tools, then how to work with the nodes and 
networks to take advantage of Houdini’s procedural nature. 

	� If you are new to 3D and Computer Graphics then Houdini is a great package to start with. The 
Foundations material assumes some general knowledge, therefore you may want to read up on CG 
concepts that you are unfamiliar with. In the end, Houdini will help you achieve a deeper understanding 
of what goes on under the hood of not only Houdini but other 3D apps as well.

Once you have finished the foundation lessons, visit SideFX.com for more tutorials. From the main menu, 
go to Learn > Learning Paths for a comprehensive list of lessons created by SideFX and members of the 
Houdini community. There are lots of lessons for you to explore as you build up your Houdini skillset.
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Everything is procedural in Houdini, which means that 
modeling, character rigging, lighting, rendering and visual 
effects all benefit from a node-based workflow where artists 
can build up networks of nodes to manage all the steps 
needed to complete a creative task. Networks can then “talk” 
to other networks to create even more sophisticated systems.

GOING PROCEDURAL
In Houdini, every action you take is stored as a node. These 
nodes are then “wired” into networks which define a “recipe” 
that can be tweaked to define a repeatable outcome where 
each iteration can generate unique results. The ability for nodes 
to pass important information down the chain, in the form of 
attributes, helps give Houdini its procedural nature.

KNOWN FOR VFX
Visual effects artists have traditionally gravitated to Houdini 
because this procedural workflow is ideal for working with 
particles and dynamics. Often visual effects are designed to 
react to actions that are taking place in a shot and a procedural 
solutions “automate” these reactions. Therefore, Houdini 
provides studios with higher levels of productivity and more 
control over the creative process.

Houdini is also capable of working with large data sets which is 
critical as visual effects become more sophisticated with many 
layers such as rigid body destruction, fluids, and particles all 
interacting to achieve the final result.

PROCEDURAL CONSTRUCTS
For motion graphics projects, a procedural approach offers lots 
of visually-stunning eye candy. These special effects are often 
the result of animating parameters on nodes and adding noise 
in interesting ways that you wouldn’t expect in real life.

THE WIDER CG PIPELINE 
Beyond VFX and motion graphics, Houdini has bread-and-
butter tools for all parts of the pipeline from modeling to 
rendering to character work and gamedev. Its procedural 
workflow supports you as you create all of your CG content. 
Along the way, you will benefit from the ability to explore 
multiple iterations and make changes deep into production.

While the nodes are what makes Houdini unique and give it its 
power, there are lots of viewport and shelf tools that are used 
to work interactively while Houdini builds the networks.

Learning Houdini
Houdini is a computer graphics, or CG, application which you can use to model, animate, render and 
simulate. In the process of learning Houdini, you will explore new ways of managing the creative 
process that involves the interactive manipulation of nodes, networks and assets.
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DO I NEED TO WRITE CODE TO USE HOUDINI?
DEFINITELY NOT! In fact, because of Houdini’s node-based workflow, you will often be able to create results  
interactively that would require writing code in other 3D applications. Houdini is very much an artist’s tool and while  
it has a technical side that uses scripts and expressions, the out-of-box tools will let you accomplish amazing things. 
And the nodes let you easily go back and make changes which mimics how the creative process works. 

If you do want to work with code then Houdini supports a number of languages inside the Houdini interface. There 
are Wrangle nodes for working with VEX and Python and PyQT is supported as well. You can also use Houdini’s  
expression language hscript or you can mix all of them together to meet your specific needs.

DIRECTABLE RESULTS
The reason you are able to make edits deep into production is 
because changes made to parameters on Houdini nodes will 
cascade right through the network to update the results. This 
directability is retained throughout the creative process and 
can be used to make last minute decisions that would be too 
costly in a traditional CG pipeline.

TOOL BUILDING
Another benefit of the node-based approach is that it is easy 
to encapsulate node networks to create custom nodes that 
are shared with colleagues without writing any code. Houdini’s 
re-usable networks can be wrapped up quickly and easily into 
special nodes called Houdini Digital Assets.

These assets open in Houdini, or in other applications such as 
Autodesk Maya, 3DS Max, Unreal and Unity using Houdini 
Engine plug-ins, with the asset’s procedural nature left intact.

 

FULL ACCESS TO ALL YOUR DATA
As objects move through a typical animation or visual effects 
pipeline, they accumulate information which is often stored as 
point or primitive attributes such as velocity, capture weights 
or UV texture coordinates. While other 3D applications hide 
this information and attempt to control it for you behind the 
scenes, Houdini gives you tools for working with and managing 
this data. This results in a much more powerful and flexible 
approach that makes a huge difference down in production.

A NEW WAY OF THINKING
As you become more proficient with Houdini, you will find 
new ways to approach a shot or a game level that will make 
you and your team more productive. Houdini gives you the 
flexibility to build tools that will support you throughout a 
project’s life cycle and instead of simply reacting to issues and 
problems, you will be able to anticipate the pain points and use 
a procedural solution to work much more efficiently. 

Now that you have chosen to learn Houdini, you will find 
yourself exploring a versatile application that will redefine how 
you approach future projects. The key is to embrace this new 
way of working and be ready to explore CG at a level deeper 
than you ever imagined. 

Andrey Bilichenko

Marina Bade
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Houdini gives artists many different ways to view the bits and 
pieces that make up a 3D scene. From the Scene View where 
you look through a camera at your geometry to the Network 
view where you manage the procedural nodes and networks, 
you will find many different ways to make creative decisions 
while making sure each shot works at a technical level. 

RADIAL MENUS
One way to access tools in the Scene View is the radial menus 
which you can access using the X, C and V hotkeys. Each of 
these brings up a radial menu with lots of options for you to 
choose from. The main focus of each menu is as follows:

	� Snapping 	 X
	� Main 	 C
	� Views	 V

Once you learn how a radial menu works, you can access the 
tool with a quick sweep gesture without dwelling on the widget. 

You can change the custom menu at the top of the menu bar 
which says Main by default. On OS X this is the Radial menu.

SHELF TOOLS
At the top of the workspace, you will find multiple shelves 
filled with tools for creating and manipulating objects, 
geometry, cameras, lights and effects.

These tools work in the scene view and often involve some 
sort of scene view interaction. Once you have used one of 
these tools, one or more nodes will be created which you can 
then refine in the Parameter and Network panes. 
The shelves provide a very important resource to new Houdini 
artists because the shelves reduce clicks and often put down 
networks of nodes that you can learn from.

TAB MENU
Another way to access tools in either the Scene view or the 
Network view is to press the tab key. This brings up a menu of 
available tools and nodes you can use in your work.

Tool Shelf - The shelf tools let you work with  
objects and geometry in the scene view.

TOOL BAR:

Selection Modes - Focus on scene,  
geometry, or dynamic objects.

Select Tools - Select, Secure Selection

Transform Tools - Move, Rotate,  
Scale or Pose or the Handle tool for  
node-specific controls.

Snapping Tools - Turn on Grid,  
Primitive, Point or Multi-snapping.

Viewing - Use the View tool to Tumble,  
Pan and Dolly or Render Region to render  
in the Scene View. Click and hold to change to 
2D Pan and Zoom.

Output Tools - You can render or  
flipbook your scene with these tools.

The Houdini Workspace
Houdini offers a user interface experience that will be familiar for artists coming from other  
CG applications with the biggest difference being the panes used to manage nodes and networks. 
The workspace is highly configurable and can be set up to support different ways of working.

Start Typing and the menu will 
show you available tools
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 3D VIEW TOOLS
Here are some of the hotkey combinations available while 
viewing. You can skip spacebar/alt if you are actually in the 
View tool:

	�  Tumble 	 Spacebar or Alt[Opt] - Left Mouse Button [LMB]
	�  Pan	 Spacebar or Alt[Opt] - Middle Mouse Button [MMB]
	�  Dolly	 Spacebar or Alt[Opt] - Right Mouse Button [RMB]

You can find the View tool in the toolbar. When you use the 
spacebar or alt keys, you temporarily evoke the view tool. This 
can be quite useful when you are selecting or manipulating in a 
view and need to quickly change your point of view. 
If you want to focus on viewing then you can press Escape to 
go to the View tool. Here are some other hotkeys, you can use 
to get your bearings:

	� Home Construction Plane	 Spacebar + H
	� Frame All 	 Spacebar + A
	� Home Selected 	 Spacebar + G

  2D PAN AND ZOOM
You can click on the 2D Pan and Zoom tool in the Operation 
Control bar to change your view in 2D without altering your 3D 
camera position. The widget at the top left lets you click to pan 
and zoom or to reset the view with Ctrl - LMB click. This is a 
great tool for working with locked off cameras. 

2D Pan and Zoom Widget

Ctrl-LMB to Reset

2D Pan and Zoom Button

2D Pan and Zoom

 FIRST PERSON CAMERA
While in the View tool, you can turn on a first person fly 
through mode similar to those used in videos games.

	� Toggle First person On/Off	 M
	� Dolly In/Out	 W/S 
	� Pan Right/Left	 A/D
	� Look Around	 LMB

VIEWPORT DISPLAY MENUS
Change how objects appear and views are organized using the 
menus in the top right of the Scene view or the V radial menu.

Shading Menu
   Object Display Menu
                         Views Menu

Shading Menu - Choose from options such as wireframe, flat 
shaded, smooth shaded or smooth wire shaded.
Object Display Menu - As you dive into networks, this menu 
sets whether you hide, view or see geometry ghosted. 
Views Menu - This menu lets you split your scene view into 
various views such as perspective or orthographic views.

DISPLAY OPTIONS BAR
At the right side of the scene view, the display bar gives you 
access to options for viewport display. Here are a few examples.

 Reference Plane/Ortho Grid - Turn on and off a grid that 
can be used for reference and for grid snapping. 

 Construction Plane - Turn on and off a construction plane 
which is used to define where you place objects or points. 

 Lock Camera- Lock the current camera to the view so that 
view changes modify the camera transform values.

 High Quality Lighting with Shadows- Set the best quality of 
viewport rendering.

 Display Primitive Normals - Show the normals belonging to 
all primitives in the scene to determine their direction.

DISPLAY OPTIONS
The Scene and Network views each have Display option panels 
that you can access by clicking on the icon at the bottom of the 
Display options bar or using the following hotkey:

  Display Options 	 D

Viewport Display Menus - These tabs let you create and 
organize multiple panes at the same time.

Pane Tabs - These tabs let you create and organize multiple 
panes at the same time.

Operation Controls - Use the Handle tool with this bar to 
access parameters from your selected node.

Parameter Pane - This pane lets you set values, add expressions 
and keyframe selected nodes.

Display Options Bar - These toggles let you control scene 
display options such as normals, point numbers or lighting.

Scene View - Visualize your work and use handles to 
manipulate objects interactively in your scene.

Network Pane - View and manage networks of nodes to work 
with the underlying structure of your scene.

Playbar - Set the current time and edit keyframes on selected 
nodes. You can also use the Playbar to copy and paste 
keyframes.

LMB-Drag to Pan 

MMB-Scroll or  

RMB-Drag to Zoom
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PANES AND PANE TABS
The Houdini workspace is divided into panes so that you 
can set up and explore your scene. Pane tabs let you overlap 
several panes within the same zone to keep them handy but 
not visible by default
You can access a pane tab by clicking on it in the workspace. 
You can close it by clicking on the x. The + menu can be used 
to change the pane you are looking at or to add new panes. 

PANE TYPES
RMB-click on the pane tab to change its type. There are many 
pane types to choose from. Here are some of them which have 
hotkeys. Some of the other ones are listed here. Refer to the 
documentation to find learn more about all of the others.

Network View [Alt-2] - This view lets you see the nodes and networks 
and connect, rewire, and reorganize them to suit your needs.

Parameters [Alt-3] - Set values on parameters, add expressions and 
control the properties of your nodes.

Tree View [Alt-4] - This is a hierarchical view of the nodes. This can be 
a great way to understand how scene hierarchies work.

Viewers > Scene View [Alt-1] - Work interactively in 3D space. This 
type of view can be set up with one or more viewports. You can have 
more than one scene view panels open at the same time to look at 
your scene from different points of view. 

Composite View [Alt-0] - View images and composites created using 
Compositing [COP] nodes.

Viewers > Motion FX View [Alt-^] - This lets you view motion created 
using Houdini’s channel operator [CHOP] nodes. 

Solaris > Scene Graph- This pane shows you the USD scene graph when 
working with Solaris [LOP] nodes.

Solaris > Render Gallery - This pane lets you save test renders then 
revert back to the settings of each image after reviewing them all.

Solaris > Light Linker - Connect lights and objects.

Render Scheduler - This panel shows you Renderings that are 
completed and in progress. You can pause and kill renderings here.

Material Palette [Alt-7] - This palette lets you see all the materials in 
your scene and select and assign them to objects and geometry.

Animation > Animation Editor [Alt-6]- Manage keyframes and 
animation curves. The editor also has Table and Dope sheet views.

Animation > Channel List - Create channel groups and manage the 
scoped channels as you animate in Houdini.

Animation > Autorigs- This pane gives you access to tools for building 
your own rig out of modules for biped, quadruped and facial rigs.

Animation > Character Picker - You can use this pane to make it easier 
to select parts of a character rig.

Panes & Desktops
The Houdini workspace is broken up into Panes which offer unique ways of organizing your scene 
data. You can work interactively in a 3D view or analyze attribute values in a spreadsheet. It is 
important to learn how these different UI elements can be used to get your work done.
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Inspectors > Geometry Spreadsheet [Alt-8]- A view of the attribute 
values you have on your geometry. This could include UVs, normals, or 
custom values you have set yourself.

Inspectors > Data Tree- This view gives you access to a light bank, 
Material Stylesheet and Object appearance list.

Mantra Rendering > Render View [Alt-9] - Start interactive Mantra 
renderings, that will update when you change something in your 
scene.

Mantra Rendering > Take List- This list lets you explore different 
“takes” by making changes to specific parameters. You can then 
manage the takes to focus on your preferred creative choices.

TOPS > Task Graph Table - The Task Graph Table shows the metadata of 
all work items in the graph, or all work items in a particular node.

Misc > Orbolt Asset Browser - This browser lets you access assets 
from Orbolt.com. To use this pane you need to log in with an orbolt.com 
account.

Misc > Textport - You can use this pane to type commands.

Misc > Python Shell -You can type Python commands using this pane.

ORGANIZING AND COLLAPSING PANES
Both panes and tool bars can be collapsed and expanded by 
clicking on the arrows found in their UI. Whole panes can be 
collapsed to the left or right and you can flip the contents 
using the center grip. These options let you focus on certain 
panes by hiding others using a single click of the mouse.

Drag here to position divider 

LMB-click here to collapse up

LMB-click here to collapse down

LMB-click here to flip panes
Alt LMB-click to flip orientation

PANE MENU
At the top left of each pane is a button for maximizing and 
minimizing the pane and an arrow which gives you access to 
the Pane menu. This menu lets you tear off the pane or a copy 
of the pane, close, or split your pane. You also have options for 
determining the UI of each pane.

DESKTOPS
As you open up tabs, add dividers and organize your pane tabs, 
you start to set up your own workspace. To save any layout, go 
to the Desktop menu (Windows > Desktop on OSX) where you 
can access saved desktops, save your own and manage them 
as you work. When you save a desktop, it will save the Pane 
layout, Radial menus and visible Shelf sets.

When you save your scene, it remembers which Desktop you 
are looking at but not any changes to the pane layout while 
working. These changes will go away unless you explicitly save 
them to the desktop or create a new desktop. 

SHELVES AND SHELF SETS
To manage the shelves at the top of the workspace, access the 
menu found under the arrow icon. You can use this to work 
with Shelf sets. You can also bring up shelf sets that might be 
hidden in your desktop.

COLOR SETTINGS
You can customize the look of the Houdini UI by choosing a color 
scheme for your workspace. Select Edit > Color Settings to bring up 
the option window then you can choose from the default Houdini 
Dark or Houdini Light. Click on the Download button to choose 
from a list of color schemes created by the Houdini community. 
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Nodes & Networks
With Houdini’s node-based workflow at the heart of its procedural architecture, the ability to work 
directly with these nodes and networks becomes very important to using it effectively. While the 
idea of nodes might sound technical, they are actually quite artist friendly and easy to work with.

As you use tools in Houdini, nodes are created and wired with 
other nodes. The resulting networks offer a history of your 
actions while providing a simple way to make changes and 
refine your work. Learning how to work effectively with the 
node networks is an important part of working with Houdini. 

NODE FLAGS
Each of the nodes have various flags which determine if it is 
displayed, locked or bypassed. You can evoke these by either 
clicking on the flag itself or using the radial node menu.

Toggle Bypass

Info Box

Toggle Freeze

Toggle Display

Toggle Template

 Display Flag [R] - This flag lets you choose the display output 
node for the network and is highlighted with a hollow ring. The 
Render flag [T] sets which node will be output for rendering and 
is highlighted with a solid circle. You can set this separately from 
the Display flag by Ctrl-clicking on the Display flag.

 Template Flag [E] - This flag displays the node in grey and can 
be used for reference or snapping. 

 Freeze Flag - This caches at the locked node and all nodes 
earlier in the chain are ignored when the network is cooked.

 Bypass Flag [B] - This flag lets you ignore the node when 
the network is cooked. 

CONNECTING AND DISCONNECTING NODES
When you work in the Viewport, nodes are often placed and 
wired together automatically. When you want to reconfigure 
how a network is set up, you will need to connect and 
disconnect nodes by hand.

Here are some ways to interact with nodes and connections in 
the Network pane:
	� Connect Node 	 LMB-drag from output to input
	� Connect Nodes 	 J drag across the nodes
	� Insert New Node 	 RMB on an output or connector
	� Insert Node 	 LMB drag and drop onto connector wire
	� Disconnect from Wires 	 LMB select then Jiggle node(s)
	� Cut Wire	 Y drag across connector wire
	� Move node	 LMB-drag
	� Copy selected nodes	 Alt + LMB-drag
	� Reference Copy	 Alt + Shift + Ctrl + LMB-drag

Dot nodes can be used to organize your networks:
	� Add Dot 	 Alt + LMB wire
	� Pin/Unpin Dot	 Alt + LMB dot

NODE GALLERIES
The galleries offer quick access to nodes that you want to add 
to your network directly. The galleries contain those nodes 
used the most in day-to-day work while the tab key gives you 
access to all the available nodes.
You can create your own galleries using the Windows >  
Gallery Manager and you can add items to your galleries by 
RMB-clicking on a node then choosing Save to Gallery... 
Nodes saved in the Mat network will also be available in the 
Material Palette as long as they are given the proper keywords 
such as Mantra for Mantra materials.

NETWORK VIEW
Network Path - The path leading to the 
current network level. You can also use 
this bar to navigate to other networks.

Pane menu - These menus and icons 
are for organizing your network.

Network Background - Use the Pane 
menu to add an image or set up a grid 
to help you organize your nodes.

Network Box - Group related nodes 
then quickly collapse and expand them.

Sticky - Add notes to help other artists 
read your network or to offer ideas for 
their networks.

Node Gallery - Drag nodes from here 
to your network. Use the filter at the 
bottom to find the node you need.
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LEARN ABOUT YOUR NODE
Bring up the Info Box using either 
the Radial Menu or MMB-press on 
the node. This panel gives you info 
about the node’s contents, groups, 
attributes and other important 
facts. This panel also highlights any 
errors that are interfering with your 
workflow.

This panel will close automatically but 
you can click on the Pin icon to keep 
it visible as you work. You can add 
comments and display them in the 
Network view using this panel. 

Node - This represents an operation that 
contributes to the final output of the network.

Network Type - Shows which network type you 
are working in.

Connector - The connecting lines show how your 
nodes are linked together and how the data is 
moving through the network.

Dot - You can add dot connectors to make it 
easier to organize your nodes.

Display Ring - This small circle shows which node 
is displayed in the Scene view.

Render Ring - This large circle indicates a render 
node even if another node is displayed. 

Comments - Node comments can be displayed 
to help other artists understand your thinking. 

Palettes - Buttons on the menu display Palettes 
that let you set the color and shape of nodes. 

NETWORK TYPES
Houdini includes different kinds of nodes which each work 
in their own context. The network type is labelled in the top 
right corner of the network view. Nodes from each type can 
connect to other networks. While the different types of nodes 
are similar in how they are wired together, they each have 
unique capabilities:

	� Scene	 Objects 	 OBJ
	� Geometry	 Surface Operators	 SOP
	� Solaris	 Lighting/Layout Operators	 LOP
	� Materials	 VEX Builder 	 MAT
	� Motion FX	 Channel Operators	 CHOP
	� VEX	 VEX Builder	 VOP
	� Outputs	 Render Operators	 ROP
	� Tasks	 Task Operators	 TOP
	� Dynamics	 Dynamic Operators	 DOP
	� Compositing	 Compositing Operators	 COP/IMG

As you work with Houdini, you will begin to learn how to use 
this “secret” language to talk about the node types and how 
they apply to working procedurally.

NETWORK PATHS
Nodes are organized hierarchically with some nodes nested 
in other nodes known as network managers or subnetworks. 
To help you manage these hierarchies, a browser-like path is 
available at the top of most panes.

                                           Pin Path

  Drag Target to another Pane

Back/Forward Button
       Path Hierarchy

Parent Node
Container Node

Use this path to navigate up and down the hierarchy or to 
other networks. By default, the path changes as you make 
selections in the scene view although you can Pin down a 
path to keep it focused. You can also drag the Target icon to a 
pinned pane to sync up their paths. 

NAVIGATING NETWORKS
To jump between network types there are a number of 
different approaches you can take. Some of these happen 
naturally as you work with objects in the scene view and 
others offer shortcuts which allow you to work more quickly. 

Selection Modes - As you select in the scene view, the 
network editor jumps to the location of the selection. 
Different selection modes will in turn take you to different 
network types as you make a selection.

Network path - You can LMB-click on a parent node to 
navigate back up the path or LMB-click on the container node 
to access parallel nodes or dive into the contents of other 
container nodes.
Radial menu - Press n to get a radial menu that lets you 
navigate up, down and to different network types.
Hotkeys - These help you navigate up and down as you work 
with a selected object.
	� Dive in 	 I
	� Jump up 	 U
	� Toggle Objects/Geometry 	 F8
	� Previous or Next Network 	 Alt + f or Alt +  

Quick Marks- These let you quickly set and return to network 
locations. You can use them as-needed and then override them 
or forget about them. They are not saved with the scene file.
	� Set a Quickmark 	 Ctrl + 1, 2, 3, 4 or 5
	� Return to a Quickmark 	 1, 2, 3, 4 or 5
	� Go Back to Previous View 	 `

SELECT AND VIEW HOTKEYS
In the network pane, you will need to pan and zoom around 
to work with the complete network. Here are the key 
combinations for these actions.
	� Pan 	 MMB
	� Zoom	 RMB
	� Select Nodes 	 LMB
	� Add to Selection 	 Shift + LMB
	� Remove from Selection 	 Ctrl + LMB
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Parameters, Channels & Attributes
All of the nodes in Houdini are driven by parameters, channels and attributes to help you achieve 
the results that you want. The terminology used in Houdini may differ from other 3D applications 
therefore it is a good idea to take a moment to understand them in a Houdini context.

PARAMETERS
Parameters refer to the values, sliders, buttons and checkboxes 
found on Houdini nodes. These are sometimes referred to as 
attributes in other applications but Houdini uses attributes in a 
different way.
You can change parameter values in the Parameter pane or 
using handles in the viewport. There is a RMB menu on each 
parameter that gives you a number of important options such 
as copying and pasting and reverting to defaults.

 SEARCHING PARAMETERS
A node might have a large number of parameters and sorting 
through them all can take time. If you click on the magnifying 
glass in the top right, you get a search bar that lets you filter 
the parameters based on name and content. You can find  
parameters using expressions, overrides and even a raw value.

CHANNELS | KEYFRAMES
You can set a keyframe on a parameter by pressing the Alt 
key and LMB-clicking on the name or value field. Once you 
have set a keyframe, the parameter’s field changes color 
and you have created an animated channel. There will now 
be keyframes associated with the parameter which you can 
access in the Animation editor.

CHANNELS | EXPRESSIONS
Instead of a raw value, you can add expressions into the 
parameter using either hScript or Python. There is a menu in the 
top right of the Parameter pane for choosing which language 
you want to use. You can press Ctrl-E to bring up an expression 
editor with a number of scripting tools to make it easier to work.

REFERENCE SCENE DATA
You can also RMB-click on a parameter and choose Reference 
> Scene Data to bring up a window for choosing specifically 
what you want to link to. Once you have made a choice from 
any node in your scene, to create a channel reference. This 
method lets you create references without worrying about the 
exact syntax needed to write the proper expression.

PARAMETER PANE
Navigation Bar- This bar lets you see where the  
node is located in the scene hierarchy.

Node Type and Name - Here you can see the 
node type and set its name. Clicking on the icon 
gives you a menu for working with the node. 

Search Bar - Click on the magnifying glass icon to 
search parameters by name or by content. 

Changed Parameter - When a parameter has been 
changed from its defaults then its value is bolded. 
The folder tab name is also bolded.

Animated Parameter - When you have keyframed  
a parameter it is highlighted in green.

Locked Parameter - You can RMB-click on a  
parameter to lock and unlock it. It will be  
highlighted in grey

Select to Match - These icons let you match 
these parameter values to other objects. 
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CUSTOM PARAMETERS
If you click on the Gear icon in the top right of the Parameter 
pane, you can choose Edit Parameter Interface. Here you can 
add custom parameters which can then be linked to other 
parts of your node network.

ATTRIBUTES
Attributes let you attach data to your geometry that can be 
used by nodes down the chain to complete an operation. A 
fuel attribute can drive a Pyro FX simulation or a UV attribute 
sets up texturing. Some attributes are created by Houdini 
nodes or you can create custom attributes. 

Class - Attributes can belong to Points, Primitives, Details and 
Vertices. This will affect how they get used down the chain. 
Type - You can set up float, integer or string attribute types 
amongst others.

ATTRIBUTE RANDOMIZE
Attribute Randomize lets you create an attribute and immediately 
randomize its values. For instance here you can see the Color, 
rotation and Scale of these boxes being randomized. 

ATTRIBUTE TRANSFER
Within a node chain, attributes are attached to geometry then 
used by other nodes. You can also pass attributes to other 
pieces of geometry using Attribute transfer. Here the sphere 
is passing color attributes to the boxes based on a defined 
threshold value. 

ATTRIBUTE WRANGLE
Houdini has a wide variety of nodes that let you create and work 
with attributes. You can also use the Attribute Wrangle node to 
use a script-based approach to this work. For a lot of Technical 
Directors this may be the most comfortable way to work. 

For artists, working with nodes will make it easier to deal with 
this kind of information. A lot of Houdini’s power is found in the 
proper use of Attributes and you will eventually need to learn 
about them.

GEOMETRY SPREADSHEET
You can view all attribute values, even invisible 
ones using the geometry spreadsheet.

Navigation Bar- This bar lets you see where 
the node is located in the scene hierarchy.

Node Name - This shows you which node is 
currently selected and which node is generating 
these attribute values.

Attribute Class Buttons - Use these buttons to 
filter which kind of attribute you are looking at.

Point Number - Here are the geometry point 
numbers to help you determine where the 
attribute is on your model.

Attribute Values - These are the values at this 
point in the node network chain.

Filter - You can type parameter names here 
to filter the list when you are working with 
lots of parameters.



 12

H
O

U
D

IN
I F

O
U

N
D

AT
IO

N
S

Selecting Geometry
Working in Houdini involves the selection and manipulation of many different elements. There are  
a number of tools and options available to help you work efficiently with objects and geometry  
components such as points, edges and primitives.

  SELECT TOOL
The Select tool lets you focus on making selections therefore 
it doesn’t have any manipulation handles. 

	�  Select Tool	 Tap S

When working with tools such as Move or Rotate and Secure 
Selection is on, you need to invoke the Select tool to make a 
selection. Toggle Secure Selection to Off to select freely.

	� Evoke the Select tool while in other Tool	  Press and Hold S 
	�   Toggle Secure Selection 	 ~

SELECTION TYPES
There are different shortkeys for adding, subtracting or 
toggling your selection as well as for selecting all or none. 
These techniques play an important part in this workflow.

	� Select 	 LMB
	� Add to Selection	 Shift + LMB
	� Remove from Selection	 Ctrl [Cmd] + LMB
	� Toggle Selection	 Ctrl [Cmd] + Shift + LMB

	� Select All 	 A [Object Level] / N [Geometry Level]
	� Select None 	 N [Object Level] / Shift + N [Geometry Level]

SELECTION TECHNIQUES
In the viewport, you can choose from four different selection 
types that offer different ways of accessing geometry.

	�  Box Select 	 F2
	�  Lasso Select 	 F3
	�  Brush Select	 F4
	�  Laser Select	 F5

There are also some selection filters that let you focus on 
visible geometry or select groups. You have a wide range of 
selection options to help make this easier as you work.

	�  Select Visible Geometry Only	 Shift + V
	�  Select Fully Contained Geometry Only	 Shift + C
	�  Select Groups or Connected Geometry	 9
	�  Select Whole Geometry	 Choose in Operation Control bar
	�  Select by Normals	 Choose in Operation Control bar

SELECTION MODES
Selection modes, give you access to objects and components. 
They also let you easily jump from object level to geometry 
level using a the buttons in the toolbar or the hotkey. 
Objects - The object network level is where you work with an 
object’s transforms. In any tool other than the View tool, the 
following hotkey will bring you back to the Object level:

	�  Objects 	 1

Geometry - You can use any of the following hotkeys, when 
not in the View tool, to jump into the geometry level with the 
chosen components available for selection.

	�  Points 	 2
	�  Edges 	 3
	�  Primitives [Faces]	 4
	�  Vertices 	 5

 TWEAK MODE
Only one geometry selection modes can be active at a time. If 
you are working with an Edit node then Tweak Mode lets you 
choose any combination of points, edges and primitives. 

SELECT MODE MENUS
Each of the selection modes comes with 
options which let you alter how you 
interact with your scene. You can access 
these options by either LMB or RMB-
clicking on each mode’s icon.

While working with components, this 
menu lets you choose to show Display or 
Current Operators. These same options 
are available at the top of the Scene view 
when working with the Edit node. 

This menu is different at the object level 
where it includes some filters for differ-
ent kind of objects as well as options for 
more easily selecting materials, con-
straints and Digital Assets.

SELECTION OPTIONS
Edit | Components You can choose which 
components you want to work with from this 
collection of buttons. Here edge selection has 
been chosen.

Select Tool - The Select tool lets you make the 
selection. To access it press the S hotkey.

Secure Selection - This locks your selection 
when using other tools. To invoke the Select  
tool with it on, press and hold on the S hotkey.

Selection Types - You can use this top bar to 
change your type of selection. You can choose 
from Box, Lasso, Brush or Laser. There are also 
some filter options.

Edge Loop - To select an edge loop you can 
double-click while selecting edges. To select 
partial loops, select one edge then press A and 
then an end edge. This works with points and 
primitives. You can also select point loops or 
primitive loops using the same technique. 



13

Se
le

ctin


g
 G

eom


et
ry

HOW SELECTIONS ARE USED BY TOOLS
When you make a selection in the viewport then use a tool, 
a node is created and the selected points, primitives or edges 
are listed in the node’s Group parameter. 

For example here we see primitives 5, 6, 9 and 10 are being 
used by a polyextrude node. You can see them listed in the 
Group node and then used to extrude the faces.

 
If you were to change the topology of the incoming geometry 
node then there might be more or less faces and the 
extrusions will have moved to a different location. This may 
not be what you want and you may need to reselect faces.

To do this, you can select polyextrude, press Enter to go to the 
Handle tool and press ` to go into re-select mode. Select new 
primitives then press Enter and your new selection will be 
used in the Group parameter.

SELECT ALL AND THE GROUP FIELD
To select all of the primitives on incoming geometry, leave 
the Group parameter blank. If the topology of the incoming 
geometry changes, everything will be operated on by the node. 
Using Select All [N] in the viewport will usually ensure that 
this field remains blank when a tool is used. With some tools, 
the Group field will show all the selected parts and you would 
have to clear the field manually to make it blank.

THE GROUP NODES
Group nodes let you refer to a defined selection of points, 
vertices, polygons, or edges by name. You can define a 
group interactively, by selecting components in the viewer, 
or mathematically, using ranges or an expression. The group 
name can then be assigned to the Group parameter instead of 
using point or primitive numbers.

 

Here are some Group nodes for you to choose from:

	� Group Create - Use interactive selection, a bounding box, face 
normal direction or edge angles to populate the group.

	� Group by Range - This lets you choose a range and a simple pattern 
to populate the group. 

	� Group Expression - With this node you can use a vex expression to 
define the membership of the group.

	� Group Paint - This node lets you use an interactive paint interface 
to choose the geometry for the group.

Shading Options - The shading  
options determine what you see in 
the Scene view. In this case, we are 
using Smooth Wired Shading.

RMB Menu - While in the Select 
tool, this menu gives you access to 
selection options such as inverted 
selections, boundaries or growing 
and shrinking your selection.

Display Filter - This filter lets you 
turn off things you don’t need 
such as bones, null objects, lights 
or cameras to let you focus on the 
work at hand.

Display Options - While selection 
modes will show you edges or 
points to help you select, they will 
not be visible when using other 
tools. Use these options to keep 
them visible even when not using a 
specific modeling tool. 
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EDITING GEOMETRY
Edit | Components You can choose 
the components you want to edit 
using these buttons. The Points 
option has been chosen here.

Move Tool - The Move tool lets 
you translate the selection using 
the Scene View handle.

Move Handle - This handle lets 
you move along one axis using the 
lines or two axes using the square 
dots. RMB-click on the handle to 
access the handle options.

Soft Edit Radius - When moving 
points on a surface, you can use 
this radius value to create a soft 
falloff as you move the points. The 
Soft Edit Radius doesn’t work with 
primitives or edges. 

Transform & Edit
From basic transformation tools for objects, to the pose tool for animation rigs and the edit node for 
reshaping geometry, there are a number of different tools that let you use interactive handles in the 
viewport. In Houdini, these handles are tied closely to the node you are working with. 

TRANSFORM TOOLS
The transform tools give you handles that you can use to 
manipulate objects or reshape geometry. When you transform 
objects, the parameters at the object level are updated to 
reflect your changes. 

	�  Move	 T
	�  Rotate	 R
	�  Scale	 E
	�  Pose	 Ctrl-R
	�  Handle	 Enter

The Handle tool gives you access to handles that are specific 
to your selected node. While using these tools, you can  
re-select by pressing and holding S, making a new selection 
then releasing S and continuing to transform.

TRANSFORM HANDLES
When you are working with a Move handle you can work with 
a single axis, two axes or move along the camera plane using 
the center. Rotate and Scale handles offer similar controls.

Single Axis

Two Axes

Camera Plane
[Three Axes]

 

MMB TRANSLATION
If you don’t want to click directly on handles, you can use 
the Middle Mouse Button in open space combined with a 
drag to move it along the construction plane. To change this 
to translate along nearest axes go to Edit > Preferences > 
Handles and set Translate Handle to Map Drag to Axis. 

MMB-Drag up/dwn

Moves along Y axis if 
the preference is set to 
Map Drag to Axis

  POSE TOOL
When you are animating, you can use the Pose tool to work 
with bones and to display motion path handles that reveal the 
motion of an object. You can then use tangent handles and 
keyframe points to modify the motion in the viewport. 

Motion Path  
Handle

IK Handle
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  EDIT NODE
If you try to move geometry components then an Edit node 
is placed down to accept your transformations. In addition 
to transforming the geometry, you can slide on surface, work 
perpendicular to the normals or sculpt the surface.

	�  Edit	 T/R/E
	�  Slide on Surface	 L
	�  Peak	 H
	�  Sculpt	 B

SOFT FALLOFF
When you are transforming points, you can use the Soft Edit 
Radius to create a falloff. There is a visualizer that is evoked to 
show you where the falloff is occurring on the surface.

Peak Handle

Soft Edit  
Visualizer

Soft Edit HUD

 

EDIT OPTIONS
If you RMB-click while in the Edit node, you can access 
options for transforming your selection. You can make a circle 
or straighten the selection. These options work with points 
and edges but not always with primitives.

	� Make Circle	 Shift-C
	� Evenly Space Selection	 Shift-E
	� Relax Selection	 Shift-R
	� Straighten Selection	 Shift-S

  HANDLE TOOL
After using a shelf tool, you often find yourself in the Handle 
tool. Or you can select a node in the network and press the 
Enter key in the Scene view to go into the Handle tool. This 
brings up a handle which focuses on the specific parameters 
for the selected node such as the distance parameter on a 
polyextrude node. 
Show Current Operator - By default when you select a node 
other than the display node, it becomes the current node and 
you get a wireframe display of the geometry. You can then 
use the handle to manipulate this intermediate node while 
evaluating the results on the shaded surface. 

Show Display Operator - Another option is to always show the 
Display Operator. In this case, selecting a node in the chain 
does not show the wireframe and the handles stay focused on 
the display node.

You can change parameters in the parameter pane for the 
current node but the handles will continue to work with the 
parameters on the display node. 

Shading Options - The shading options 
determine what you see in the Scene view. In 
this case, we are using Smooth Wired Shading.

Sloppy Selection - Three of the component 
buttons can be selected at the same time if the 
Edit node is using Sloppy selection which makes 
all of them available for a more fluid selection 
process.

RMB Menu - This menu gives you access to Edit 
tool options such as which type of edit you want 
to focus on. This information is also available on 
the top bar of the Scene view. 

Component Selection - You can also select the 
component type using this menu. This offers 
you the same options you would find on the 
main toolbar.

Edit Options - You can use this menu to edit 
the components using operations such as Make 
circles and Straighten the selection.

HANDLE OPTIONS
All handles have a menu that can 
be accessed by RMB-clicking on 
any part of the handle.

This menu gives you options for  
aligning the handle, detaching it 
from the parameters of the node, 
pivot mode and more. You can 
use these options to customize 
how the handle works.

You can also keyframe param-
eters on a handle and promote 
all parts of the handle to a Digital 
Asset. By promoting the param-
eter the handle will be accessible 
at the asset level.
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Modeling Tools
Houdini has a lot of tools for creating, shaping and deforming geometry to achieve a desired look. 
Here are just a few of the many tools you will use on a regular basis when building models in the 
geometry, or SOP, context of Houdini.

CREATION
To start creating geometry, you can start with some basic 
shapes or draw a curve. In each case you get an object with  
a geometry/SOP node inside with the tool’s name. You can  
access these on the Create shelf or in a radial menu.

 Primitives - Houdini includes Box, Sphere, Tube and Torus primitive 
shapes along with a variety of Platonic solids.

 Grid - The grid tool offers a great starting point for a wide range of 
models. You can set its shape and size at the geometry level.

 Curve - Draw a curve by laying down control points then create a 
Bezier, NURBS or poly curve.

POLYGON MODELING
Polygons are one of the most popular geometry types 
especially in video game projects where they are mandatory. 
Houdini has a comprehensive set of poly modeling tools which 
you can use to develop your models.

 PolyDraw - This tool lets you interactively draw a polygonal mesh 
on the construction plane or by snapping to existing geometry.

 PolyExtrude - Push or pull on one or more polygons to reshape the 
geometry. Control the extrusion profile to get a wide variety of shapes. 

 PolyBevel - Bevel selected edges to create chamfered or rounded 
bevels. You can often use the output group from a previous node such 
as Polyextrude or Boolean to automatically find the right edges.

 PolyBridge - Connect two sets of polygons with control over the 
shape of the bridge.

 PolySplit/Edge Loop/Knife - These tools let you split polygons to 
add more detail to your model.

 PolyExpand 2D - Take curves and edges that sit on a 2D plane and 
creates geometry based on a desired offset value.

 PolyReduce - Create different levels of detail by reducing the 
number of polygons while preserving quads and UVs.

 PointWeld- Interactively snaps groups of points to another target 
point, and merges them.

UTILITY NODES
Because of Houdini’s procedural nature, modeling actions like 
copy, clip and mirror create nodes in your network. This can 
makes it easier to go back and make changes later on. 

 Clip - Cut your model based on a clipping plane. You can set the 
direction of the clip and whether you keep one half, the other or both.

 Mirror - This tool flips the geometry based on a clipping plane. 
There is an option to fusing the points after mirroring.

 Copy and Transform- This node will let you create multiple copies 
based on transformation values.

 Blast - This node lets you delete polygons from your model. You 
can choose to remove or keep the selected polygons. If you press the 
Delete key when points or a polygons are selected they will be blasted.

 Dissolve - This tool lets you remove edges without breaking up 
the surrounding geometry. Pressing the Delete key when an edge is 
selected will dissolve it.

  SUBDIVISION SURFACE MODELING
In Houdini, you can model with polygons then display and  
render them as subdivision surfaces using options found on 
the Render tab on the object’s parameter pane. You can also 
create a Subdivide node at the geometry level to add polygons 
to give you a more detailed topology to work with.

 

SURFACING TOOLS
There are tools in Houdini that will take profile curves and 
build surfaces. Those input curves can be either bezier, 
polygonal or NURBS or a mixture of them.

 Revolve- Create geometry by revolving a profile curve around an 
axis. There is a handle available for tweaking the results.

 Skin - Take a series of profile curves and turn them into a surface.

 Rails - Copy one or more profile curves along two or more rail 
curves, then Skin the results to get a surface.
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  BOOLEANS
Subtract, Union or Intersect geometry using the Boolean tool. 
This node can handle very complex topologies and can be 
used to break up a surface for destruction using rigid body 
dynamics. This often creates more realistic results compared to 
the Voronoi-based Shatter node. 

The Boolean tool can create output groups that you can use 
to feed other nodes such as the Polybevel node. This way any 
updates you make to the boolean will update properly when it 
feeds into the second node. 

DEFORM TOOLS
While you can shape your geometry by editing points directly, 
there are times that you need a more generalized approach. 
The following nodes provide options for shaping your 
geometry procedurally.

 Bend - This node lets you set a capture range and direction then 
bend, twist, taper and squish the encompassed geometry.

 Lattice - This builds a lattice around your geometry then lets you 
edit points on the cage to reshape it. You can also use a custom cage.

 Mountain - Apply a noise function to deform the surface to create 
a random result. The points are actually being moved with this node.

 Ripple - This node creates a ripple shape in your geometry.

 Waves - This node adds noise functions to create a wave-like  
pattern that animates over time. Perfect for creating realistic oceans.

   COPY TO POINTS + SCATTER & ALIGN
A typical Houdini workflow is to Scatter & Align points on a 
surface then Copy to Points. Attributes for scaling and rotating the 
objects can then be applied to create a more organic result. This is 
often used to create landscapes with trees and rocks. 

  TOPOBUILD
Houdini has a Topobuild node that lets you draw polygons 
directly onto high-resolution geometry that you either scanned 
or created in an application such as Pixologic’s Z-Brush. You 
can create a cleaner topology for animation then bake the 
details from the original model into a normal map. 

  VOLUMES
Volumes allow you to store values for voxel, or three 
dimensional pixels, in a space. These are often used to support 
collisions when using dynamic tools or to create clouds. They 
can also be used for modeling to combine multiple shapes into 
a single volume which you then convert back to a surface.

 

GEOMETRY TYPES
Houdini supports a number of different geometry types including Primitives,  
Polygons, NURBS and Beziers. You can Convert back and forth between them and 
you can have more than one geometry type merged together in a single object. 

Polygons models can be set up to display and render as Subdivision Surfaces using 
PIXAR’s OpenSubdiv standard. Both Subdivisions and NURBS will render in Karma 
and Mantra as perfectly smooth without relying on any tessellation settings.
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UVs & Textures
To make 2D maps fit properly onto 3D objects, UV coordinates are needed to define a flattened 
view of your geometry. When you first create geometry in Houdini it will not have any UVs. Even 
primitive objects do not have any built-in UVs. This means that you will need to add them at the 
geometry level using one or more SOP nodes.

UV TEXTURE DISPLAY
Since geometry in Houdini does not have UV texture 
attributes set up by default, you need to add them 
using UV tools. Once you have UVs set up, you will see 
a texture grid on your geometry because Show UV Texture is 
on in the Display Options bar. You can toggle it off if you don’t 
want to see the UV texture or change it to a color texture. 

UV PROJECT
This node let you assign UVs using one of several projection 
techniques. Once you choose your projection type you can 
initialize the projection to match your object. This may invert 
the UVs and you will need to set a rotate x value of -90 instead 
of 90. Above you can see an Orthographic projection and 
below you can see a Toroidal projection. 

UV FLATTEN
UV Flatten unwraps your geometry based on predefined 
boundaries created using selected edges or edge groups. The 
results can then be tweaked by pinning points in the UV view 
and adjusting the islands to get the look you want. 

UV EDIT & DISTORTION
To edit individual vertices or groups of vertices you will use 
either the UVedit or UVtransform nodes. The UVedit node lets 
you perform many edits using a single node while UVtransform 
allows one edit per node which can provide a more procedural 
result. You can use Display > UV Distortion from the UV 
Viewport menu to see whether you are editing too much.

UV LAYOUT
UV layout will let you create UV islands and pack them into 
UV space as efficiently as possible. This lets you maximize how 
much of a texture is being used on your geometry which is 
important when optimizing for both rendering and gameplay.

You can use the region handle to put a the UV layout into a 
particular part of your UV space. Subsequent layouts can then 
work around this layout using the Pack Islands in Cavities option. 

UDIMS
In addition to working with a Single UV tile, you can use 
UDIMs to spread your UVs over many tiles. This technique 
lets you create more detailed texture maps because your UV 
islands are not packed in too tight. Properly numbered texture 
maps will then be assigned to the appropriate tile.

Statue scan from threedscans.com
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UV ATTRIBUTES
Earlier, you learned how attributes can be assigned to 
geometry that carry important information down the line. UVs 
are vertex attributes that let you wrap texture maps around 
your model and are also carried down your network. 
These attributes are visualized in the UV viewport and 
analyzed in the geometry spreadsheet. These attributes work 
with various SOP nodes including the attribute wrangle node 
which lets advanced TDs manage their UVs using scripting.

UV SETS
You can create more than one UV set on the same geometry. 
When you use the UV nodes, you can set the UV attribute. By 
default this is uv but you could create a uv2 to create a second 
set. These different UV sets are used when you assign textures in 
VOPs so that different texture maps use different UV attributes.

In the two images shown here, the first uses a toroidal 
projection and is assigned to a uv UV attribute while the 
second uses a planar projection and is assigned to a uv2 UV 
attribute. These UV attributes can have any name, for instance, 
it could be bob instead of uv2.

UV VIEWPORT MENU
The UV viewport menu lets you display UVs based on the 
UV attribute. You can also use this menu to figure out the 
background image which can either be the default UV grid or a 
texture map pulled from an assigned material. 

This menu also has display options for displaying UV Overlap, 
UV Backfaces and UV Distortion. These can be helpful when 
evaluating your UVs to decide if more tweaking is required.

ATTRIBUTE TRANSFER
One of the SOP nodes that can be used to manage attributes is 
Attribute Transfer which lets you take the UV attributes from 
one piece of geometry and transfer them based on proximity 
to another. 
This can be useful when the topology of a model has changed 
but you want to preserve some of the work you did creating 
UVs for the original model.

SCENE VIEW | UVS

Current Tool - At the top of 
the Scene View, you will find 
the selected node when the 
Handle tool is active.

Background - The 
background of the main tile 
can be set using options 
found in the UV menu.

Outside Main Tile - Polygons 
positioned in the area 
outside the main tile would 
overlap the same area on the 
main tile because the texture 
repeats unless you are using 
UDIMS which cover more 
than one tile.

UV menu - When you are in 
the UV view, this menu gives 
you a number of different 
options for working with UVs.

View menu - Use this menu 
to choose the UV view for this 
viewport.

Layout Handle - This handle 
is part of the UV Layout node 
and lets you focus the UVs to 
a certain part of the tile.

Pack Around - The UV layout 
will pack your UVs around any 
existing geometry that has 
already had its UVs set. 
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LookDev: Shaders & Materials
To render objects in your scene, you must assign materials, also known as shaders, to your geometry. 
In Houdini, these materials and shaders are created in the mat/vex builder networks. The ability to 
build up materials using nodes is a powerful tool when defining the look of a shot.

Houdini organizes different types of nodes into network types 
and for materials you will use the /mat network type. This is 
where you can set up VEX operators for Karma and Mantra 
or Material X for Karma. Material X is an open standard, that 
originated at Lucasfilm,® which is used or the transfer of look-
development content between applications and renderers. 

THE MATERIAL PALETTE
You can add VEX-based materials using the Material Palette 
then assign them to objects by clicking and dragging. This 
pane has a workspace for managing the materials in your 
scene which is organized into tabs that represent different 
subnetworks such as Material Library LOPS. Use the tab key 
to add Material X shaders to material networks. Once they are 
in place they will show up in the Material Palette.

ASSIGNING MATERIALS IN LOPS
To assign a material in the Solaris LOP context, first create a 
Material Library LOP which contains a /mat network. You can 
assign the material using this node or use an Assign Material 
LOP later in the chain. The Material Palette will let you drag 
from the gallery to the library or in LOPS you can use the 
arrow button to access a list of materials in your scene graph.

PRINCIPLED SHADER
In the Material Palette, you will find the principled shader, 
a material based on the Disney “principled” BRDF by Brent 
Burley. This shader is “principled” rather than physical in order 
to make it easier for artists to work with.
The Principled Shader has been pre-built to include the ability 
to assign textures directly to parameters such as base color, 
bumps, normals, displacements and more. The texture maps 
you assign will be displayed in the viewport and you can 
achieve a wide variety of looks right out of the box. 
You can extend this material by feeding it with other VOPs but 
that isn’t necessary in all cases. Many of the materials found in 
the gallery are variations on this shader.

PRINCIPLED SHADER CORE
The Principled Shader Core node sits inside the Principled 
Shader and contains the main features of the shading model 
but doesn’t have all of the texturing features built-in. 
To build a robust shader from scratch using this node, you 
would need to add VOP nodes using Houdini’s shader building 
tools. You can accomplish this by either wiring nodes together 
in the Node view or adding them using the Shader FX menus.

MATERIAL PALETTE

Materials in Gallery - The 
Materials listed here are saved 
to disk in a gallery file. You 
can drag these into the scene 
area found on the right or onto 
objects in the viewport.

Material in Scene - This is where 
you find materials that are part 
of your scene file. They can be 
assigned to objects by dragging 
from here into the viewport.

Material Library LOP - Materials 
set up in the LOP context can be 
placed into Material Libraries - 
you can drag materials into here 
from the gallery.

Update Material Icon - To 
update all material icons 
you can click on this button 
or RMB-click on material to 
do it one at a time.

Assign Material - If you 
select an object in the 
scene and the material in 
the palette then you can 
use this button to assign the 
material.

Double Click to Edit - If you 
double-click on any of these 
materials, you will jump to a 
Node View where you can 
make edits at the /mat level.
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SHADER BUILDING

Node Path - This will confirm your 
current path and help you navigate 
into and out of the material network.

VOP Nodes - In the material context, 
you can start with material nodes 
then wire in VOP nodes to customize 
the texturing of the material. Once 
you are finished you can choose 
to collapse all of this back into a 
material builder node.

Node Connectors - You can add 
nodes to this area using the Shader 
FX menu which can be accessed by 
MMB-clicking on the dot. RMB-
clicking on the dot gives you a full 
node menu.

Principled Material - This is a 
typical material which can be 
assigned on its own or fed  
into the Layer mix.

Layer Mix - The Layer output  
on the materials can be fed  
into this mix node. You can  
assign this to your geometry.

Material Flag- If you want  
the layer mix to show up  
in the material palette then 
check this flag. 

Alpha - Here the layer mix 
node’s alpha is being fed by  
VOP nodes to create the  
alpha mask for the two  
layered materials.

LAYERING MATERIALS
You can layer materials to create a unique look for your object. 
Using a Layer Mix node, you can combine two different 
materials into a single look. For instance, a shiny metal material 
and a matte rust material can be layered using this technique. 
You can then texture an alpha channel and you can choose to 
mix the surface, the displacement or both.

MATERIAL BUILDER
If you want to turn your layered nodes into a new material 
then you can select them and choose Edit > Collapse Selected 
into Material. This puts the nodes inside a material builder 
where you can continue to tweak it. At this level, there are 
output and collect nodes to make the network work efficiently.

MATERIALS AS DIGITAL ASSETS
You can make materials even more efficient by saving them out 
as Houdini Digital Assets. In the Asset Properties pane, you 
can go to the Save tab and choose Save Cached Code so that 
the material is pre-compiled when you render with Mantra. You 
can also load texture maps into the digital asset then reference 
them from inside the asset file. Turning materials into HDA’s 
can make it easier to share with your team.

SHADER FX MENU
While working with material VOPs, you can add nodes in the 
Network view and wire them together or you can use the 
Shader FX Menu by clicking on the icon at the far right of each 
parameter. This menu lets you focus on the parameter that you 
want to work with and create the node in context.

In the Parameter Pane, you can see what type of connection 
each parameter has by looking at the icon on the far right:

	� No Connection	  
	� Parameter Node	  
	� Connected with other Nodes	  
	� Hidden Connection	  

PROCEDURAL MATERIAL ASSIGNMENT
When working in production with lots of data, it is often necessary 
to take a procedural approach to assigning materials. With Solaris 
and Karma, you can accomplish this using nodes such as the Assign 
Material LOP or Material Variation LOP. 
If you are working with Mantra, materials can be assigned to the 
object using the Data Tree panel which gives you access to 
Material stylesheets. Stylesheets let you use rules to assign 
materials and textures to large groups of objects. 



 22

H
O

U
D

IN
I F

O
U

N
D

AT
IO

N
S

Solaris: Layout
Solaris is the context in Houdini dedicated to Lookdev, Layout and Lighting that has USD at its core. 
Objects and geometry brought into this context become USD and you can use specialized nodes for 
positioning objects, instancing geometry and managing shot layout.

SOLARIS: LOPS
The Solaris environment can be found in the /stage network 
or by creating a LOP network. Here you will place nodes for 
bringing in geometry, assigning materials and adding lights 
and cameras. These nodes let you create sequences and shots 
using shared assets and procedural edit nodes to customize 
settings for each shot.

At its core, the Solaris environment converts everything into 
USD [Universal Scene Description] which is an open source 
initiative created by PIXAR. The Solaris/LOPS context allows 
you to work with USD natively using procedural nodes to 
manage USD concepts such as references, payloads, layers, 
collections, variants and level of detail.

LOP networks can then be rendered using either Karma or 
other Hydra-compatible renderers. Hydra is the technology 
that lets you render your USD to the viewport for interactive 
exploration or to disk for final renderings.

SCENE IMPORT: OBJECTS TO LOPS
For artists used to working at Houdini’s Object level for layout 
and lighting, the Scene Import LOP node makes it easy to 
bring your geometry, lights and cameras into LOPS to render. 
If your goal is to create a controlled USD scene graph then you 
may want to take another approach but for quick access to 
Karma and other renderers the Scene Import node works fine.

PREPARING ASSETS FOR USD
Another approach is for you to configure props using either 
a Component Builder LOP network or the USD Export SOP. 
This would be geometry and materials set up on a prop-by-
prop basis then exported as USD for use in the layout stage. 

 

For some of the props, you will use variants to create differ-
ent variations that can be chosen during layout. There are LOP 
nodes that let you set up this USD concept.
Once you have the props set up as USD, the files can then 
be brought into a larger layout scene file using Sublayer or 
Reference LOPS then Edit LOPs can be used to position the 
props. If the assets are prepped properly then they will come in 
with geometry, materials and variants set up and ready.

SOLARIS DESKTOP

Stage - The Stage view provides 
a place for viewing your layout 
and lighting and to interact with 
primitives, lights and cameras to 
set them up properly.

Viewport Render - On the stage, 
you can render using Houdini GL 
or Storm the USD GL solution. 
You can also render interactively 
to Karma and Hydra compliant 
3rd party renderers.

Scene Graph - The USD 
structure offers a renderable 
scene graph that can be 
inspected using this panel.

Stage Manager - This 
node lets you load USD 
files to be positioned on 
the stage.

LOP Nodes - All your 
actions in LOPS are 
accomplished using 
procedural nodes that 
make it easy to step 
back and make changes.

Scene Graph Details - 
As you select items in 
the Scene Graph you 
can check for details 
that inform you of its 
status in the pipeline.
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SCENE GRAPH

Stage - This is the top level 
network context for creating 
LOPS. You can also do all of this 
work in LOP Networks.

Scene Graph Path - These 
represent the USD layers and 
sublayers that define the look of 
the stage. These are most likely 
different USD files on disk being 
referenced into a shot.

Primitive Type - Each primitive 
comes with a type or schema 
that defines how it works. 
This can help you determine 
the contribution each layer is 
making to the stage.

Draw Mode - Here you 
can change the display  
of any element in the path 
to either Full Geometry, 
Bounding Box or Textured 
Cards.

Display Options- Here 
you can set the visibility 
or activation of each layer. 
It is not possible to delete 
anything from the scene 
graph therefore hiding or 
deactivating is necessary. 

Variants- If a Layer has 
variants then the chosen 
one is displayed here.

STAGE MANAGER
The Stage Manager is designed to be a one-stop node for 
referencing USD assets from disk, transforming them in 3d 
space, and adjusting your scene hierarchy. This does involve 
a flattening of the inputting layers which will block up-stream 
changes from coming through. This lack of flexibility is 
balanced by the rapid setup possibilities of this node.

PHYSICALLY-BASED EDITS 
Once you have all of the props loaded onto the Stage, you 
can use the Edit LOP to begin moving them around. The edits 
become a separate non-destructive layer which keeps the 
referenced assets intact in case you need to step back.

In the Edit LOP, there is a Use Physics option that lets you 
leverage the rigid body capabilities of Houdini to detect 
collisions and make it easier to position objects in a realistic 
manner. This lets the artist achieve a natural organic look while 
working interactively in the 3D view.

INSTANCING
There is an instancing solution in USD that can be utilized in LOPS. 
The Instance LOP lets you input one or more objects that will be 
distributed to points set up inside the LOP. These points can be 
created by importing geometry from your scene then scattering 
points on surfaces extracted from the model.
Materials can be assigned to the instances using a variety of 
methods including the Material Variation LOP which also offers 
per-geometry render properties.

You can also use the Layout Asset Browser and the Layout LOP to 
use a brush workflow to place, edit and transform instance points 
that reference the assets you choose in the browser.

EXPORTING USD
At various points in your LOP graph, you can inspect the USD 
code by RMB-clicking on the node and selecting LOP Actions 
> Inspect Active Layer. You can also inspect the Flattened 
Stage. When you export to USD, you can break out all the 
layers or save it as a single flattened graph.
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Solaris: Cameras and Lights
Before you render a shot, you need to look through a camera and light your scene. There are lights 
and cameras in the Solaris/LOPS context which is especially designed for layout, lookdev, lighting and 
rendering with Karma or at the object level for rendering with Mantra.

  CAMERA
Cameras can be accessed from the LOP Lights and Cameras 
shelf. Press Alt-click on the shelf tool to convert your current 
view into a camera view. If you create the camera node in the 
Network view, click on the No Cam menu in the top left of the 
viewport to look through it. 

To adjust the camera, you can use the Camera handles either 
from another view or while looking through the camera. There 
is a  lock camera to view button in the Display Options bar 
that lets you use the View tools to reposition the camera.

There is a  lock camera to view button in the Display 
Options bar that lets you use the View tools to reposition 
the camera. Just make sure that you don’t leave this on later 
otherwise your camera view may get changed by a simple view 
change. Once you like a camera view, you may want to lock its 
transform values to avoid losing it to a view change.

CAMERA PROPERTIES
The Cameras in the LOP Context have key properties that 
determine how the camera will generate images. 

View Tab

	� Projection - Choose between perspective or orthoganal projection.
	� Focal Length - Determines the length of the lens. Smaller values 

create wider shots and higher values create long shots.
	� Horizontal/Vertical Apperture - Aperture is a gate that controls 

how much light goes into your camera.

Sampling Tab

	� Shutter Open/Close - Determines how long the shutter is open 
which has an effect on motion blur.

	� Focus Distance - Distance from the camera to the focal plane. 
Determines which objects are in focus when using Depth of Field.

	� F-Stop - Lens aperture. Default is 0, which turns off focusing.

Press Shift + F to show a visualization of the focal plane and 
how it intersects geometry. When looking through a camera, 
you can Shift-click or drag on a surface to move the focal 
plane to intersect that point. Otherwise, you can use a handle 
on the focal plane to move it and set your Depth of Field.

LIGHTING SETUP

Viewport Rendering - To 
make lighting decisions, it is 
important be able to render in 
the viewport using either Karma 
or other renderers such as 
RenderMan or Arnold. 

You can also use HoudiniGL but 
this is not as effective as one of 
the main renderers.

Light Handles - You can step 
back and manipulate lights in 
the view in a similar manner to 
cameras or you can use special 
controls to set lights right in the 
camera view.

Primitive Path - This sets 
where your light will be in 
the USD scene graph. 

Light Type - You can choose 
your light type from this 
menu. The Light LOP gives 
you access to all the light 
types and you can switch 
between them.

Light Parameters - There 
are a range of parameters 
for controlling light 
properties such as cone 
angle and intensity.

Light LOP Nodes - Every 
light is added into the 
network as a LOP node.

SHOW FOCAL PLANE 
[Shift- F]

Shift-click  
on Surface
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LIGHT MIXER

Light List - This list shows all the 
lights feeding into the mixer.

Collection - You can organize lights 
into collections so that they work as 
a group in the mixer.

Solo Lights - Click on the star icon to 
solor the light or the collection.

Intensity Slider - The first slider gives 
you control over the intensity of your 
lights or light collections.

Exposure Slider - The second slider 
gives you control over exposure 
which offers a tweak to the intensity.

Light Color - Click here to tint the 
light or the collection of lights.

  LIGHTS
Lights can also be accessed from the shelf and have similar 
handles to help you position them. There are a number of 
different light types in Houdini to choose from.

 Point Light - Emits light from a point in all directions and is similar 
to a light bulb. 

 Spot Light - Radiates a cone shaped beam of light from a point in a 
certain direction.

 Area Light- Automatically distributes a number of light sources over 
a specified area. There are five area light shapes to choose from: Line, 
Tube, Grid, Disk an Sphere.

 Geometry Light- This object emits light into the scene using a 
geometry object’s surface shader for the colors of the emitted light.

 Distant Light- Emits parallel rays of light, which are similar to the 
rays of the sun.

 Environment Light- Casts light into the scene as if from a 
surrounding hemisphere or sphere. 

LIGHTING WHILE IN THE CAMERA VIEW 
When you have a Light or Light Mixer LOP selected and 
displayed, you can set many of its properties while looking 
through the camera. You can use the Specular [Shift-S], 
Diffuse [Shift-D] or Shadow [Shift-F] options that let you click 
on surfaces in the scene to set up the light. 

You can then use Ctrl-drag to change the distance of the light 
from your shot and Ctrl-Shift-drag to change the brightness. 
Doing this in the viewport lets you stay focused on the shot 
you are working on instead of pulling away to drag on handles.

LIGHT LINKER
Linking lights to specific objects is a great way to control the 
lighting of the shot and this can be accomplished in Solaris 
using a Light Linker LOP. This node includes an interface for 
making the object/light connections that you need.

You can use collections of lights to apply the linking more 
efficiently using rules that define the interactions between 
primitives and lights. 

INSTANCING LIGHTS
Within the Solaris/LOP context, you can use Houdini’s 
procedural geometry nodes to create points then Instance 
Lights to those points. You can then add attributes to the 
points to create effects such as a rotating intensity you might 
find in an old school marquee. This approach makes it easier 
to set up the lights and even easier to add effects and make 
changes to meet the needs of the shot.

LMB-click to place Pivot

SHADOW MODE 
[Shift- F]

Shift -LMB-click 
to place Target
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Rendering
When you render a shot, you are digitally photographing or filming your 3D objects using cameras 
and lights to generate either an image or a sequence of images. Game artists may also use rendering 
to render game cinematics or to bake textures from a high resolution to a low resolution object. 

KARMA
Karma is a physically-based ray-tracer built to work with USD 
files in the Solaris/LOPS context. It works on the CPU and 
includes features such as adaptive tesselation for displacement 
and subdivision surfaces, multi-segment motion blur, 
instancing, hair & fur and strong volume rendering support. 
Karma works with Hydra,the USD imaging framework. This 
makes it available in the Viewport for interactive updates or 
you can render to disk using a Karma node.

Karma works with shaders created using VEX, USD preview 
and Material X. 

KARMA XPU
Houdini 19.5 includes a beta version of the Karma XPU render 
engine. This hybrid GPU/CPU renderer is being released in 
Alpha. Many features are still under development and this 
engine is for testing purposes only. You can choose XPU in the 
Scene view’s Display Options or in the Karma node.

Karma XPU works with USD preview shaders and Material X 
but does not work with VEX.

3RD PARTY RENDERERS
With its support for USD, Solaris makes it possible to render to 
other Hydra delegates such as RenderMan, Autodesk Arnold, 
V-Ray, Maxon RedShift and AMD ProRender.

 

VIEWPORT RENDERING
One of the key benefits of the Karma renderer is the ability 
to use it in the perspective view. By choosing Karma, you get 
interactive rendering that helps you make lighting and lookdev 
decisions within the Solaris/LOPS context.

 

VIEWPORT | KARMA

Render Settings - To render to disk,  
you can use the Karma LOP to define your 
render settings. Here you can set a path 
for rendering to disk, camera  
settings and more.

Karma LOP - Add the Karma LOP to the 
end of a Solaris node network. Different 
versions of this LOP can be used to set up 
unique results such as test renderings or 
final shots.

MPlay - You can either render from both 
Karma and Mantra to MPlay directly or 
render to disk then open up with MPlay 
to review the results. 



27

Re
nd


er

in
g

MPLAY 

MPlay lets you view images 
rendered in Karma, Mantra or 
other renderers. 

Main Menu - This menu lets 
you load images or sequences 
of images to preview them. 
You can also save them out to 
another format if needed. 

Render Layers - This menu lets 
you display different render 
layers such as color, normal, 
diffuse_direct or reflect-direct.

Playbar - If you have loaded up 
a sequence of images then you 
can use these controls to play 
and scrub through the sequence.

Render Time - Since you are 
sometimes rendering directly 
to this view, render time info 
will be displayed.

View Options - MMB-drag to 
pan and RMB-drag to zoom in 
and out of the image.

Channels - You can click on 
these buttons to focus on red, 
green, blue or alpha channels 
or to see them combined. 

Gamma Settings - Set the 
brightness, contrast and 
gamma for the viewport. By 
default a gamma of 2.2 is used 
to support a linear workflow.

RENDER SETTINGS
When rendering the Stage, you use the viewport render 
settings. To create the final look of your rendering, the Karma 
LOP can be used to set a frame range, camera resolution, 
denoiser and higher quality render settings. 

RENDER GALLERY
The Render Gallery lets you take Snapshots of your progress. 
Each snapshot contains all the settings of the look and at 
any time the scene can be reverted to match the snapshot. 
Snapshots can then be labelled and filtered for easy access. 

MANTRA
Mantra is the Houdini renderer developed before Solaris was 
introduced. It is a physically-based rendering engine that is 
deeply integrated with highly efficient rendering of geometry, 
instances and volumes but it does not work in Solaris/LOPS. 

OUTPUT NODES
To render out a shot, you will need to create a render output 
node. You can do this by choosing Render > Create Render 
Node > Mantra - PBR. 

You can also add a Karma ROP to the output network using 
the tab key. This has a LOP network inside it that grabs all the 
visible objects from the object level. 
You can use ROP nodes to render to disk or to Mplay. These 
nodes contain many of the parameters that you need to 
control the final image such as sampling, noise level and overall 
render quality.
It is possible to have a different ROP per object or group of 
objects and you can use them to select Mattes and Phantom 
objects. You can create ROP dependencies by wiring different 
nodes together. If you press the render button on the last node 
in the chain then all the other nodes will render first. 

RENDER OUTPUTS | AOVS
On the ROP, you will find controls for setting up Image Planes to 
create render layers for Direct lighting, Indirect lighting, Shadows, 
Depth etc. Both Karma and Mantra can render out these passes 
which can be loaded in Houdini’s compositing context, COPS, or 
in an external compositor such as Nuke. 

The Background Plate LOP can be used to matte objects in 
order to leave holes in the scene to make the background 
visible. This geometry can take shadows and contribute to 
reflections to create a more realistic fit for your objects.
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Time & Motion
Animation involves changes happening over time. Whether it is an object’s position, shape or color, 
once changes occur over time, you are animating. Houdini has a variety of tools for keyframe-based 
workflows in addition to Motion FX & CHOPs for more advanced manipulation of time and motion.

PLAYBAR
The Playbar is where you scrub through time and create and edit keyframes. The Playbar can also be used to 
make quick edits, while the Animation Editor is used for more comprehensive refinements.

  SETTING KEYFRAMES
Keyframes let you set specific parameter values at a specific 
points in time. As these values change, the objects in your 
scene are animated. You can then use animation curves to 
determine the in-between quality of the motion. Here are a 
few main hotkeys used to set keyframes on your objects while 
working in the scene view:

	� Set Keyframe	K
	� Toggle AutoKey	 Alt + K
	� Key Handle	 Ctrl + K
	� Key Translate	 Shift + T
	� Key Rotate	 Shift +R
	� Key Scale	 Shift + E

You can also set keyframes in the parameter pane by 
pressing the Alt key and clicking on either a parameter 
name or parameter field or by RMB-clicking on a parameter 
and selecting Keyframes > Set Keyframe. This lets you set 
keyframes one parameter at a time

  THE PLAYBAR
The Playbar is at the bottom of the main workspace and lets you 
playback and scrub through your animations. Time is measured in 
frames with a default rate of 24 frames per second. 
At the left are the playback controls. Here are some hotkeys 
for quickly setting up playback and moving through time. 

	� Play Forward	 

	� Play Back	 

	� Next Frame	 

	� Previous Frame	 

	� First Frame	 Ctrl + 
	� Next Keyframe	 Ctrl + 
	� Previous Keyframe	 Ctrl + 

The Playbar can also be used to edit keyframes. You can RMB-
click on the frame range in the Playbar to access options such 
as Cut, Copy and Paste of keys along with special pasting such 
as Replace, Cycle, Repeat and Stretch. All these options also 
have their own hotkeys which you can find on the menu. You 
can accomplish a lot working in the Playbar before moving to 
the Animation Editor.

CHANNELS
When you set a keyframe or display animation curves in the 
Animation Editor, you are working with channels. 
If you select an object that has keyframed channels then they 
become active and the keyframes are loaded into the Playbar 
or Animation Editor. If you deselect the object then the 
channels will no longer be selected unless you pin them. 
You can pin channels using the Channel List which is available 
on the right side of the Playbar, the left side of the Animation 
Editor or in the Channel List pane. In this list, you can select 
one or more channels to refine which of them you are 
keyframing and editing. 

CHANNEL LIST PANE
The Channel List pane, lets you work with Channel Groups, 
Animation Layers and Active Channels. You can use the list 
to create groups of channels so that they can be more easily 
accessed. You can also use the groups to pin channels so that 
they are available even if you select different objects. This is a 
useful pane if you are setting keyframes on characters.

  FLIPBOOK	
As you animate your scene, you will want to preview the  
results in motion. The Flipbook tool found on the toolbar on 
the left side of the Scene view lets you capture frames from 
the viewport then playback the results as a movie in realtime.

Current Time 

The current time is 
shown in the field and on 
the black marker in the 
frame range. The marker 
can be used to scrub 
through the Playbar. 

Frame Range
The overall range is defined 
by the Animation controls 
button at the far left. Then 
the visible range can be 
reduced using the handles 
at the bottom of the range.

Edit Keys
As you set keys, they are 
shown in the Playbar. Press 
the shift key to select keys 
with the LMB and then edit 
the keys by dragging with 
the MMB.

Set Key
The Set Key button will 
set keyframes when you 
click here. Click on the 
small arrow to bring up 
a menu of options such 
as Auto key.

Playback Controls
These controls let you 
quickly play, pause, and 
move to next key. Below 
that are buttons for 
Animation options and 
Real Time playback. 
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ONION SKINNING	
Onion Skinning lets you display a ghosted version of your object 
on the frames before and after the current frame. Turn it on using 
the Misc tab on your object while the onion skinning options such 
as Frames Before, Frame After and Frame Increment can be found 
in the viewport’s Display panel [d] under the Scene tab.

  MOTION PATH HANDLES
When using the Pose tool to animate, you can click on the  
Motion Path option to bring up handles that let you see the 
animation of the selected object over time. You can also use 
the handle to manipulate the shape of the motion. 

Motion Path Handle

Onion Skinning

ANIMATION EDITOR
Selected channels are loaded into the animation editor where 
they are represented as keyframes and animation curves, or as 
a spreadsheet or a dope sheet. The keyframes can be selected 
and edited and the curves can be shaped using tangent handles. 
The curves define the motion in-between the keyframes and 
play a key role in defining the quality of the motion. 
While working with channels, you can view the keyframes and 
animation curves using these hotkeys:

	� View All/Home 	 H
	� Pan 	 MMB
	� Zoom	 RMB

MOTION FX
While keyframes and animation curves are stored in the 
parameters of your nodes, you can also use channel operators 
(CHOPs) for a more procedural node-based approach to 
working with motion. 
The easiest way to create a channel operator is to RMB-click 
on a parameter and select from the Motion FX sub-menu. You 
can also apply these effects to channel groups when working 
in the Channel List.

Motion FX can be applied to keyframed motion which is 
extracted and stored in a Channel CHOP. You can then apply 
effects such as cycle, noise, smooth, limit or lag to the existing 
motion. On the Constraints shelf, you have tools which let you 
have one parameter either look at, lag or jiggle behind another.

This non-linear approach to working with motion offers a 
unique way of working that can be very flexible.

ANIMATION EDITOR 

Editor Options - This editor 
can be shown as a graph, a 
dope sheet or a table.

Channel Groups - This area 
of the graph shows channel 
groups which make it easier 
to select and pin channels.

Animation Layers - This 
area lets you layer different 
channels on top of each other 
to create multiple iterations.

Channel List - Channels on 
selected objects show up in 
this area. You can then select 
the names of channels you 
want to see in the graph.

Key Handles - Move the key 
back and forth in time using 
the vertical bar or edit its 
value using the box.

Tangent Handles - They 
define the tangents coming 
in and out of a keyframe to 
help you shape the curves.

Curve - The animation 
curves determines the 
motion in-between the 
keyframes, which defines  
the quality of the motion. 

Curve Functions - These 
let you set various display 
options for the animation 
curves and handles.

Tangent Handles
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Character Rigging & FX
Houdini includes a wide range of rigging tools for creating characters and creatures that can then be 
wrapped into Houdini Digital Assets to be handed off to animators. Houdini also has Character FX 
tools such as hair, fur, muscles, cloth and crowds to enhance the look of your characters. 

  BONES
In Houdini, you draw and edit bones using the Bones tool and 
the Bones from Curve tool found on the Rigging shelf. Each 
bone chain is made up of a chain root and bones. Whereas 
other 3D apps are joint-based, Houdini uses Bone nodes that 
have parameters for Length and Rest Angle. 
You can also use the Bones tool to add inverse kinematics to 
the chain which adds an end effector and in some cases a twist 
effector. The kinematics are driven by Channel Operator or 
CHOP nodes which exist in their own subnetwork.

CAPTURING GEOMETRY
The character’s geometry can then be captured to the bones 
to create the deformations needed to convey realistic motion. 
Houdini bones include Capture Regions that you can set up 
to encompass your geometry while creating the right overlap 
at the joints. This process results in weighted attributes being 
assigned to the points that get fed into a Deform node that 
controls the geometry when the bones are moved and rotated.

At first, captured geometry might not get you exactly the look 
you want, therefore you would use various tools to Edit and 
Paint Capture Weights. This lets you smooth out the weighting 
at the joints to create more realistic bending. You can also 
smooth out the effect of point deformations using a Delta 
Mush node that wires into the Deform node.
A new technique called Bone Capture Biharmonic allows you 
to capture geometry without requiring extensive point weights 
to get a desirable look at the joints. This method sets up 
biharmonic functions on a tetrahedral mesh to create a much 
more holistic solution. 

DIGITAL ASSET CHARACTERS
To rig a Houdini character and share it with the animation 
team, you will need to wrap up the bones, geometry and 
materials into a Houdini Digital Asset. 
This creates a file on disk that can be easily referenced by 
animators into multiple shots. Handles and key parameters 
are made available at the top level so that Animators can set 
keyframes without worrying about the inner workings of the 
rig. You can also save Pose Library and Character picker setups 
into the asset for quick access.

Changes made to any part of that character are saved into 
the asset and all shots will be updated. This creates a robust 
character pipeline that is easy to manage.

  KINEFX
KineFX is a character toolset designed to provide a procedural 
foundation for retargeting, motion editing, and in future 
releases, rigging and animation. Set in the geometry context, 
these new workflows make rigging a fast, plug-and-play 
experience with unlimited flexibility and caching capabilities.
Implemented in the geometry [SOP] context, KineFX treats 
joints as regular point geometry with edge connections 
defining the rig hierarchy. You can bring rigs in from the object 
level of Houdini or import FBX characters.
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CHARACTER PICKER

This pane lets you create an 
interface for choosing parts of 
your rig. This can then be saved 
into a file that you add to your 
Digital Asset file on disk.

Tabs - Set up multiple tabs for 
different areas of the body such 
as hands, feet or face.

Controls - Place markers for the 
different handles on your rig 
then add text or color to help 
you distinguish between them.

Background Image - Add a 
visual representation of your 
character to properly associate 
the markers with the parts of 
the body.

CHANNEL GROUPS
When you animate in Houdini, channels that are scoped can 
be keyframed and displayed in the Animation Editor. Generally 
these channels are based on your current selection. You can 
also put together Channel Groups that let you scope and pin 
down channels to assist with keyframing.
When you have a character set up as a Digital Asset, you can 
click on its icon at the top left of the parameter pane and 
choose Parameters and Channels > Create Nested Channel 
Groups to create groups using the asset’s folder hierarchy as a 
guide. A well designed character asset makes this easy.

CHARACTER FX | HAIR & FUR
Houdini has a hair and fur toolset that you can use to setup 
and groom your character starting with the Add Hair tool. 
These tools also let you work with guide hairs and then 
animate them using wire sims to create added realism.

CHARACTER FX | MUSCLES & SKIN
Houdini lets you add muscles to an animated creature and 
then apply them as a skin deformer without requiring any 
simulation. Start by creating simple muscle forms using the 
Muscle nodes in the geometry context. 
You then adjust the muscle’s shape and placement, attach it to 
your character rig then enable automatic secondary animation 
or jiggle. Houdini’s muscle system has been designed to serve 
both FEM (dynamics simulations) and non-FEM (skin deformer) 
workflows while using a unified set of Digital Assets.

CROWD SIMULATIONS
A crowd simulation begins with agents that are made up of a 
character skeleton, skin geometry, and animation clips. These 
are assigned to points, where simple rules can combine to 
create complex behaviors and the agents can interact with 
other dynamic elements. For example, an agent might be 
struck by a passing car and become a rag-doll or a crowd might 
be triggered to react to an action on the field. 

POSE LIBRARY

The Pose Library pane lets 
you capture poses and clips 
from your character for future 
reference. You can go to a frame 
in your Playbar and apply the 
pose by clicking on it here.

Pose - These save out a pose 
taken from a single frame. All of 
the parameter settings at that 
pose would be applied to the 
character in your current scene. 
You would then use this to 
interpolate to another pose.

Clip - A clip contains a set of 
keyframes for a longer time 
period. These might be a walk 
cycle or a particular movement 
like a back clip.
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Dynamic Simulations
Whether you are creating Bullet Rigid Body destruction, Pyro FX fire and smoke, Vellum 
Soft Bodies or FLIP fluids, Houdini lets you work in an integrated dynamics environment.  
Different solvers know how to talk to each other to allow for more directable results.

SHELF TOOLS
Setting up dynamic simulations involve a network of nodes 
in the Dynamic or DOPS context, as well as nodes at the 
Geometry or SOPS context. It is always a good idea to use the 
shelf tools because they will add all of these nodes for you and 
reduce the number of clicks needed to set up a sim. You can 
then dive into the networks to explore all of the nodes.

 

 

The shelf tools are great for setting up groups of nodes 
automatically. Seeing how these shelf-built networks are put 
together can be very useful later if you choose to set up DOP 
networks from scratch.

DYNAMIC SOLVERS
At the center of any simulation is the dynamic solver. It is the 
brain of the simulation and takes all of the dynamic objects, 
forces and collision objects and integrates them to create the 
final result. The shelf tools put these solvers into a Dynamic 
Network and wire up the nodes for you.

 Rigid Body Solver- Simulate rigid objects falling and colliding using 
the efficient Bullet solver or Houdini’s built-in solver. 

 Static Solver- For situations where you want objects to work as 
collision geometry but not be affected by the simulation. 

 Flip Solver - This solver creates FLIP Fluid simulations to create 
splashing and wave effects.

 Whitewater Solver - After completing a FLIP solve, you can run this 
solver to create foam, spray and bubbles.

 Vellum Solver- A type of POP Solver that includes integrated 
support for cloth, hair, grains, fluids and soft bodies such as balloons.

 POP Solver- Used for particles and grains, this solver simulates a 
wide range of different particle-based scenarios. Grain simulations can 
also be used for soft body and cloth-like simulations.

 Wire Solver- You can use this solver for hair and fur or other wiry 
objects such as the rigging of a ship or the branches of a tree.

 Finite Element Solver- Simulates the physics of continuous materials 
or solids as determined by tetrahedrons. This solver is used for muscles, 
soft body sims and destructions shots such as breaking wood.

 Cloth Solver- Create cloth simulations that can collide with 
deforming geometry such as a character.

 SOP Solver- Use a SOP network to evolve an object’s shape over 
time such as a wall being dented as it gets hit by objects.

OPENCL
You can use the GPU for faster sim times using OpenCL on 
solvers such as the POP Grain node, the Pyro solver (Advanced 
tab) and the FLIP solver (Volume Motion > Solver tab).

FORCES
To create dynamic motion, forces are needed to “get the ball 
rolling.” The most basic of forces is gravity although other 
external forces such as fans, fluids and magnets can also play a 
role in initiating motion in your simulation.

 Gravity Force A downward force on objects which works as if they 
were inside a gravity field. 

 Drag Force - Applies force and torque to oppose an object’s existing 
motion to slow it down or dampen its momentum.

 Uniform Force- A precise amount of force and torque that can be 
augmented by a noise DOP to add turbulence.

 Fan Force- Applies a cone-shaped force on objects.

 Fluid Force- Deform soft bodies such as cloth or wires with fluids.

 Wind Force- A pushing force that will increase the velocity of 
objects up to but not beyond its own speed.

 Magnet Force- Attracts or repels objects using metaballs to 
represent a force field. 

 Vortex Force- Creates a vortex-like force that causes objects to 
orbit around a curve much like objects around a tornado.

DYNAMIC OBJECTS
When you select an object and use a shelf tool to add it to 
your simulation, Houdini creates a Dynamic Object that uses 
the object’s geometry and adds dynamic properties such as 
density, friction, and bounciness.

ACTIVE VS STATIC
Active dynamic objects are affected by forces and collisions 
while Static objects are not. If you want to use animated or 
deforming geometry then you must define this on the dynamic 
object using either the Initial Object Type menu or the Use 
Deforming Geometry checkbox.
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AUTODOPNETWORK

When you use a shelf tool to create 
a dynamic object, collision object 
or force, the AutoDopNetwork is 
created to combine all of the parts.

Static Objects - These nodes set up 
the properties of the ground plane 
and a static collision object.

Static Solver - This solver keeps the 
incoming objects still while dynamic 
objects interact with them.

Merge Node - Brings together 
parts of a dynamic system. During 
simulation nodes are evaluated 
up and down the chain so that 
everything interacts.

Dynamic Object - This node 
brings geometry into the 
DOPs environment and 
assigns basic properties.

Rigid Body Solver - The solver 
that generates the simulation 
of the participating objects.

Forces - The nodes that 
influence the dynamic objects 
using forces such as gravity 
or wind. 

Output node - You can use 
this node to output .sim files 
if you want to cache out the 
simulation.

COLLISIONS
Collision objects are also a big part of any simulation. You 
can set up a Ground Plane to create a continuous surface for 
collisions or use either static or deforming objects.

On each Dynamic Object, there are also settings for displaying 
and optimizing the collision volume. While you often want 
collisions to be as accurate as possible, you need to balance 
that with the need for faster simulation times. 

RIGID BODY CONSTRAINTS
On the Rigid Bodies shelf, you will find a number of constraints 
that can also be used to influence a simulation. These include 
Pin, Spring and Slider Constraints. You can also use Glue Objects 
when you set up a rigid body sim to hold objects together until 
you either “loosen up” the glue or a collision occurs.

PLAYBAR FEEDBACK
To start a simulation, you press Play in the Playbar. As the 
simulation progresses, the Playbar is highlighted to show how 
much of the sim has been cached to memory. You can then 
scrub through that area without re-simming. 

CACHING TO DISK
Once you have completed a simulation, you can either lock 
it down by saving out a sim file from within DOPs or more 
commonly, write out the simulated geometry to a bgeo 
sequence using the File Cache node. This will make it easier to 
work with the results of a sim during the lighting and rendering 
stages of production. 

REALTIME FX FOR GAMES
In games, you need effects, such as explosions, to be optimized for 
real time in the game engine. Check out the SideFX Labs Tools to 
learn more about converting different kinds of Houdini sims such 
as rigid bodies, Pyro FX and Fluids into game ready art. 
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Cloud FX & Volumes
A big part of visual effects in Houdini is the use of volumetric data. In Houdini, volumes often 
sit under the hood to help tools get the job done but it is a good idea to learn what they are 
and, in time, learn how to work with them directly.

With volumes, you describe objects using voxels rather than 
points and polygons. A voxel is a 3D pixel, a cubic grid where 
each voxel contains information that informs how the volume 
will be displayed which makes it ideal for wispy cloud-like 
shapes. The visual quality of a volume-based object is defined 
by the resolution of that 3D grid. With more resolution, 
the results are of a higher quality but performance may be 
affected.

 

ISO OFFSET
The Isooffset node found in the geometry context lets you 
take any manifold Polygon geometry and construct a Houdini 
Volume for Houdini to use. You can choose from a variety of 
different Output types to see the shape as fog or a tetra mesh.

Original Geo Fog Tetra mesh: Cubes

CLOUD FX
This toolset converts geometry into a cloud-like VDB volume 
complete with lighting. The Cloud Rig tool can be useful 
for shaping an individual cloud, or simply as a way to better 
understand lower-level tools such as Cloud, Cloud Noise and 
Cloud light that all contribute to the final look.

The resulting network imports the cloud source then applies 
these other nodes to create the cloud-like effect using Houdini 
Volumes and VDBs. Houdini also comes with a Sky Rig tool 
that fills the sky with volumetric clouds.

To create a cloudscape for a game engine such as Unreal you 
can use a Sky rig in Houdini, then convert it to a mesh and use 
it as a spawn surface. There is a tutorial on the SideFX website 
by Andreas Glad that teaches this approach.

OPEN VDB
“OpenVDB is an Academy Award-winning open-source C++ 
library comprising a suite of tools for the efficient storage and 
manipulation of sparse volumetric data discretized on three-
dimensional grids. It is developed and maintained by DreamWorks 
Animation for use in volumetric applications typically encountered 
in feature film production.” - openvdb.org

Houdini has a variety of OpenVDB Volume nodes available in 
geometry [SOP] networks that convert geometry into volumes.

VOLUMES UNDER THE HOOD
Many of the tools in Houdini make use of volumes under the 
hood where you can’t see them. Here are some of the areas 
where volumes are making contributions to your work. 

	� Colliders - By default, volumes convert geometry into colliders for 
dynamic simulations.

	� Simulation Fields - Volumes define fields such as density or velocity 
that contribute to dynamic simulations. 

	� Hair and Fur tools - These tools use volume data to assist with 
grooming calculations.

	� Terrain - Heightfield tools use 2D volumes where each voxel  
contains the height of the terrain at each grid point.

	� Rendering - Volumes create water depth and fog effects in Mantra.



35

Te
rr

ain


 &
 H

ei
g

htfi


e
lds



Terrain & Heightfields
Procedural terrain generation in Houdini is achieved using a collection of heightfield nodes that  
let you layer shapes, add noise and run erosion simulations to define the look for your digital 
landscapes. This a workflow that is similar to compositing, but you do all your work with 3D shapes.

Houdini provides a variety of geometry nodes for generating 
and shaping terrain. These tools represent terrain using 2D 
volumes where each voxel contains the height of the terrain at 
that grid point, called heightfields. The data passing through a 
geometry network can contain multiple heightfields. You can 
access these tools using the Terrain desktop. 
The Houdini viewport lets you visualize the 2D heightfield 
as a 3D surface, and the mask field is displayed as a red tint 
on the 3D surface. There is a dedicated Mantra procedural 
for rendering heightfields and they can be used as collision 
surfaces for dynamic simulations.

PATTERNS
After laying down a Heightfield node to define your base 
resolution, the Heightfield Pattern node gives you access to a 
number of starter shapes. You can set up linear, concentric, or 
radial ramps, linear steps, radially symmetrical shapes such as 
stars and voronoi cells.
These shapes can then be blurred and distorted to get shapes 
that you can use to begin your terrain. You can also combine 
and layer elements to achieve even more sophisticated results. 

NOISE
As you build up your terrain, you can then add noise to layer 
in a natural look. You can choose from a variety of different 
types of noise including, Perlin, Sinusoid, Worley and more. This 
adds realism to your terrain and by combining different shapes 
with different kinds of noise, you can achieve a wide variety of 
hyper realistic results.

MASKS
The heightfield tools also use a secondary type of 2D volume, 
where each voxel contains a mask layer. Most terrain nodes 
take a second input that can contain a mask layer to control 
which parts of the terrain the node will modify.
You can use a variety of different methods to create masks and 
then use them to assist you as you add detail and shape the 
terrain. You can also draw or paint masks onto the heightfield. 

EROSION
The Heightfield Erode node uses rainfall, the erodibility of the 
soil, and entrainment rates as variables to simulate erosion and 
deposit buildup. This node works iteratively during playback. 
It will appear to have no effect on the first frame. You need to 
press play in the Playbar to watch as it sims the erosion. 

EXPORT OPTIONS
There are a couple of different ways to export your terrain for 
use in another application such as a game engine. You can use 
the Heightfield Output node to export height and/or mask 
layers to disk as an image then bring these in as textures. 
You can also create Houdini Digital Assets that will open up in 
applications such as Unreal and Unity using the Houdini Engine 
plug-ins. In the game engine, these Digital Assets will interact 
with built-in Terrain tools.

ARON KAMOLZ
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SideFX Labs
SideFX Labs is a collection of high level tools aimed to speed up artist and gamedev related 
workflows in Houdini. There are a growing number of tools being developed that range 
from Mesh Processing, Realtime FX, UVing, to creating Motion Vectors from simulations. 

While all of Houdini can be used to generate content for film, 
TV and games, the Labs toolset addresses artist-specific tasks 
that may not be available in Houdini today. These tools are 
developed separately from the regular Houdini development 
cycle and become available the moment they are ready for 
testing. They can be downloaded directly from within Houdini 
or accessed through the SideFX Labs github page.

DOWNLOADING THE TOOLS
The Labs tools can be installed with Houdini or accessed from 
the SideFX Labs shelf tab. It not visible on most desktops so 
you will need to add it. Once it is visible, click on the Update 
Toolset button. This will pop up a dialog prompting you to 
install. Since many tools are in beta, you may want to turn Off 
the Production Builds Only option.

 
The shelf will be populated with many of the tools but some 
are only available when you press tab in the Viewport or 
Network view. These nodes are prefaced with Labs to make 
them easy to find.

FX TOOLS 
Houdini is known for its strong FX tools and SideFX Labs has 
tools to process the results for use in a realtime environment 
for games or virtual production. Labs has a range of tools to 
help optimize and export your sims to textures, fbx, csv, etc.

 Vertex Animation Textures - The Vertex Animation Textures ROP 
will export a mesh and textures to be used with a realtime material 
that can playback complex animations for cloth, rigid body destruction, 
fluids and particles.

 

 Flipbooks Texture - Fast GL or Karma based creation and preview of 
texture atlases for Pyro FX.

 Destruction Cleanup - Prepare rigid body simulation results for 
export, reducing redundant geometry, cleaning normals, cleaning 
attributes.

 Skinning Converter- Skinning Converter is a SOP that can convert 
any non-changing topology deforming mesh sequence into a bone 
based animation.

 Make Loop - Takes a mesh, points or volume that is animated and 
loops them.

 Volume to Texture - The Volume Texture tool lets you write out a 
texture that can be used with Ryan Brucks’ volume plugin in UE4.

 Flowmap - This utility tool sets up a flowmap template on your 
input geometry.

 Flowmap Visualize - A high quality realtime preview of a flowmap 
texture in the Houdini viewport.

 Flowmap Obstacle - The flowmap obstacle SOP allows for easy 
modifications on the flowmap based on geometry.

 Niagara ROP - All-in-one HDA to extract and write out impacts, 
split data and interpolation data from a bullet sim to be used with the 
UE4 Niagara data interface.

 Gamedev Procedural Smoke - The procedural smoke SOP will 
generate an animated volume to represent smoke.

 ROP Vector Field - Generate UE4 compatible vector fields from 
volumes or point clouds.

MESH PROCESSING
There are a lot of steps to get quality meshes into your games - 
photogrammetry, topology cleanup, mesh reduction, uv layout, 
baking maps. Lab tools let you simplify that process with 
wrapped up workflows and integrations with popular software.

 AliceVision Photogrammetry - AliceVision is a Photogrammetric 
Computer Vision Framework which provides a 3D Reconstruction and 
Camera Tracking algorithms.

 ZBrush Bridge - GoZ is Zbrush’s fast file transfer feature that lets 
you send meshes between Houdini and Zbrush seamlessly without 
having to deal with file paths or extensions. 

 Delete Small Parts - Removes parts based on connectivity and size.

 Delight - Removes ambient lighting information found in high-res 
photogrammetry scans.

 GameRes - Full Pipeline Node to Take High Res Models to Low Res.

 Maps Baker - Generates textures bakes from a high resolution to 
low resolution model at near interactive speeds.

 LOD Hierarchy - Create and export an LOD Hierarchy as FBX. 

 Mesh Sharpen - This tool sharpens the geometry based on the 
curvature found on the mesh. 

 Edge Damage - This tool will add edge wear to your geometry. 
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WORLD BUILDING 
Digital worlds are becoming bigger and more complex and 
it is important to have an efficient world building workflow. 
Whether you want to recreate New York City, grow a dense 
forest or add interior details to your sci-fi adventure there are 
Lab tools for you.

 Physics Painter - Physics Painter is a SOP that allows users to paint 
physics objects onto any other object.

 Building Generator - Convert low-resolution blockout geometry 
into detailed buildings using a library of user defined modules.

 OSM Import - Open Street Map is a great database for city street 
data. This node efficiently loads the OSM files into Houdini as well as 
all of the different tagged attributes on the buildings and streets.

 OSM Buildings - Generate Buildings from OSM Data.

 Tree Tools - The Tree Tools in Labs consist out of several tools that 
can be used together to create intricate branching structures such as 
trees, bushes, plants and much more.

 Cable Generator - Given a curve that represents the high ‘pin’ 
points and low ‘sag’ points of a cable, this sop will generate sagging 
cables, with user definable cable count, shape, color.

 Curve Branches- Scatters curves over curves, with many intuitive 
controls to go from clean geometric branches to organic vines. 
Duplicates of this sop can be chained together for recursive growth, 
approximating the look of L-Systems but much more controllable.

 Dirt Skirt - Create a geometry ‘skirt’ where an object and ground 
plane intersect, to be used as a soft blend in a game engine.

 Lot Subdivision - Divide polygons into panels. Useful for city blocks 
or greeble.

 MapBox - Generate color, height and Open Street Map (OSM) 
curves using data provided by mapbox.com.

 SciFi Panels - Example HDA to generate Sci Fi Paneling.

 Snow Buildup - Adds geometry to an input mesh to mimic the build 
up of snow.

 Terrain Texture Output - The Terrain Texture Rop SOP renders 
image data from a heightfield.

MODELING
The Labs Tools includes a variety of modeling tools designed to 
make it easier to create game-ready geometry.

 Decal Projector - Project a decal (localized piece of geometry and a 
texture) onto geometry.

 Calculate Slope - Calculate the slope of a surface by comparing to a 
direction, and optionally blur and remap the result.

 Curve Sweep - Sweep a profile along input curves, with simple 
controls for profile type, width, and twist behavior.

 Extract Silhouette - Create an outline of an object projected from 
one of the axes, xyz.

UV MAPPING
Texture UVs are a big part of creating game art and these tools 
augment Houdini’s existing UV toolset to make you faster and 
more efficient.

 Auto UV - Automatically generates the seams for an object and 
immediately runs a UV Flatten after the fact.

 Inside Face UVs - Create UV’s for inside faces of fractured geometry.

 UV Transfer - Transfer uv’s between a source and target geometry.

 UV Visualize - Helper script to visualize UVs. Including features 
such as: Visualize Seams, Warp between UV space and Model Space, 
Modify the tiling of the grid texture and Visualize Islands.

 Texel Density - This tool calculates the current texel density of an 
asset per primitive based on the asset and project resolution. 

INTEGRATIONS
These tools make it easier to import and export data into 
Houdini and out to game engines.

 Substance COP - The Substance Plugin for Houdini lets you load 
Substance Archive files into Houdini in COPs.

 Rizom UV- The RizomUV Bridge is a set of 4 different SOPs that 
facilitate the communication between Houdini and RizomUV.

 Quad Remesher - The QuadRemesher node is a wrapper around 
Exoside’s QuadRemesher command line interface.

 Instant Meshes - Reads in DDS (DirectDraw Surface) Files.

 Sketchfab - Uploads geometry to Sketchfab.

 3D Facebook Image - Quickly render a 3D scene to a 2.5D image 
that can be uploaded to Facebook.

 Marmoset ROP- The Marmoset ROP allows you to quickly generate 
an mview inside Houdini.

 Gaea Tor Processor - The Gaea Tor Processor allows you to load up 
build .TOR files made in Gaea.

UX
Some Labs tools are specifically designed to enhance the user 
experience for artists working with Houdini.

 Crash Recovery - Found under the File> menu, this functionality 
allows for quick recovery from an unfortunate crashed file.

 Network Paint - Allows for colorful annotations of the network by 
simply drawing in the network editor.

 Sticker Placer - Helpful for annotating networks by placing 
numbers, icons and user-created graphics.

 External Script Editor - Sets up a live connection with an external 
IDE when working with VEX, Python, OpenCL and expressions.

AND MUCH MORE...
More Tools are being added on a regular basis. Go to SideFX.com/labs
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File Management
Understanding how to manage all of the files you create while working with Houdini is very 
important to your success as an artist. A typical scene file can have outside dependencies on disk 
and managing these is important especially if you are moving your files to a different computer.

PROJECT DIRECTORIES
While Houdini can work with files scattered all over your hard 
drive, this will make it harder to share your work and manage 
file dependencies. It is better to set up project directories 
using File > New Project or use File > Set Project to choose an 
existing project directory as the home base for your work. This 
will make it easier to set up local dependencies with respect to 
all of the required project files.

SCENE FILES | .HIP
The main file type when working with Houdini is the .hip file. 
This file contains all your nodes and networks and is the file 
type used when you save your work.

UNIVERSAL SCENE DESCRIPTION | USD
In Houdini, the Solaris lighting and lookdev environment works 
with USD [Universal Scene Description] which is an open 
source initiative created by PIXAR. In Solaris, USD is native 
and you can use procedural nodes to manage references, 
payloads, layers, collections, variants and level of detail.

HOUDINI DIGITAL ASSETS | .HDA
You can also encapsulate then save out Houdini networks into 
Houdini Digital Asset or .hda files. Parameters from inside the 
asset can then be promoted to the top level to create a custom 
UI for the asset. These files can be easily shared with other 
artists and provide a robust referencing architecture as your 
assets evolve through the life cycle of a project.

To create and load assets you can use the Asset menu. You 
can also manage assets loaded into your scene using the 
Asset Manager found on that menu. If you have two HDA 
files loaded into your scene that have the same name, Houdini 
will choose one of them based on rules set up in the manager. 
Changes made to an asset definition in an HDA file will be 
automatically pulled into scenes that reference that file. Note 
that older Digital Asset files may have a .otl extension which 
will work exactly the same as .hda files.

APPRENTICE AND INDIE FILES
Houdini Apprentice and Houdini Indie use different file types 
that cannot be opened in a commercial version of Houdini. 
Apprentice uses .hipnc (non-commercial) for scenes and .hdanc 
files for assets and Indie uses .hiplc (limited commercial) for 
scenes and .hdalc files for assets.

BACKING UP YOUR WORK
By default, Houdini creates a numbered backup of your scene 
files and Digital Asset files every time you save. This gives you 
a file to go back to if you want to review an early iteration or 
if something happens to your working file. You can also set up 
Houdini to AutoSave in the Edit > Preferences > Save and Load 
Options. Just remember that all those backup files take up disk 
space and you will want to clear them from time to time. 
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FILE SOP
When you import geometry into Houdini using File > Import 
> Geometry it puts down a File node at the geometry (SOP) 
level. This file maintains a connection to the file on disk and 
changes made to that file will also update in your Houdini 
scene. If you want to break this connection then you would 
need to lock the File node. 

FILE DEPENDENCIES [$HIP/$JOB]
When you work with nodes that reference files on disk such 
as geometry or texture files, the path you use will determine 
what happens if you move the project directory to another 
computer or to the cloud. A direct path will break if you move 
the files therefore you should either use $HIP which uses the 
scene file as the “home base” for the path or $JOB which uses 
the project directory. You can use Render > Preflight Scene to 
check to make sure that your scene file is set up properly.

DISK SPACE MANAGEMENT
Large scene files, backup files and large simulations can take 
up lots of disk space. Be sure that you are not filling up too 
much space on your computer which could lead to instability 
issues. Try to use external drives to save out the largest files 
and leave the main disk on your computer with enough space 
to accomplish your day-to-day work.

INTEROPERABILITY
To import and export from Houdini, there are a wide variety of 
file formats that you can use. Here is a list of some of the main 
formats you will work with in a typical Houdini pipeline.

Houdini Files - Here are some file formats, other than .hip and 
.hda that work exclusively in Houdini. 
.bgeo - This format saves geometry along with related attributes such 
as UVs, velocity and normals. Animations and simulations can be saved 
out as numbered bgeo files to save out motion. A bgeo.gz file is a 
compressed version of this format.

.sim - These files let you save out simulation data to cache the sim to 
disk. Some people use these files while others use .bgeos to cache sims.

.ifd - This is a scene description format that is created when rendering 
to Mantra. Typically these are created while rendering in Houdini but 
sometimes they are saved to disk to be rendered by Mantra directly.

.pic - This is an image file format that was used by Houdini in the past. 
It was replaced as the default format by the open source EXR. 

.rat - This image format is ideal for texture maps being rendered in 
Mantra. All textures get converted to this format anyway so it speeds 
up rendering to convert to this format using Mplay.

Image Formats - These industry-standard formats are used to 
render out shots and for texture maps.
.exr - OpenEXR is a high dynamic-range (HDR) image file format 
developed by Industrial Light & Magic that is now the default format 
for saving out renderings from Houdini. 

.jpg/.png - These formats are used to publish images to the web 

.tga/.tif - These formats are often used to texture map video games. 

Geometry Formats - When importing and exporting geometry, 
these formats are the most popular.
.usd - This is the format used in Solaris/LOPS and provides an open 
source interchange format for sharing with other applications.

.abc - Alembic is an open computer graphics interchange framework. 

.fbx - This format owned by Autodesk is popular when exchanging data 
with game engines and other 3D applications. It can hold geometry, 
rigging, motion and shader information. 

.obj - This is an simple geometry format originally created by Wavefront.

PREFLIGHT PANEL

From the Render menu, select Preflight Scene 
to evaluate your scene setup.

Referenced Files - The preflight panel can 
either reference $HIP or $JOB when verifying 
file references for your scene file.

Greenlit Reference - If the reference is 
relative to either $HIP or $JOB then it will be 
displayed in green to indicate it is working.

Incorrect Reference - If a file reference is a 
direct path and not relative to $HIP or $JOB 
then it will be displayed in red and will need 
to get fixed before sharing your project with 
other artists or on the cloud.

Edit Expression - Click on any file name then 
on the right click on the expression to open 
up the edit expression window.
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Expressions & Scripting
Houdini is a production-level solution which means that scripting will play an important role in your 
work. Artists can usually get by with simply writing expressions while technical directors will spend 
more time using these techniques. Houdini includes support for Hscript, Python and VEX.

HSCRIPT EXPRESSIONS
HScript is designed to be a fast and concise way to retrieve and 
manipulate information that can be used to write expressions. 
An expression is typically any value that is not either a simple 
string or number. This can be something as simple as a variable, 
a math equation or an expression function.

You can enter expressions directly into a parameter by simply 
typing into a field. When you press Enter the field highlights in 
green. You can click on the parameter name to toggle back and 
forth between the expression and the result of the expression.
If you are creating channel references then you can RMB-click 
on a parameter and choose Copy Parameter then go to the 
parameter you want to link it to and choose Paste Relative 
References.
You can also achieve this by RMB clicking on the second 
parameter then choosing Reference > Scene Data. This opens 
up a panel where you can choose data from other objects and 
nodes and an expression will be built for you. This method can 
even set expressions on multiple parameters.

EXPRESSION EDITOR
Depending on the complexity of your function, or the type of 
parameter, you may instead choose to use the Expression  
Editor. The expression editor can be opened by RMB-clicking 
on a parameter and selecting Expression > Edit Expression, or 
by placing the mouse over the parameter and pressing Alt - E.

PYTHON
Python is a popular scripting language that is well known in the 
CG industry that supports integration and standardization. This 
makes it perfect for tool development. 
Python in Houdini is built on the Houdini Object Model 
(HOM) which is an API that lets you get information from 
and control Houdini using the Python scripting language. In 

Python, the hou package is the top of a hierarchy of modules, 
functions, and classes that define the HOM. The hou module 
is automatically imported when you are writing expressions in 
the parameter editor and in the hython command-line shell.
You can also use it to write expressions in Houdini. To do 
this, change the expression language option at the top of the 
parameter pane for the node.

 
There is also a Python Shell Panel which you can use to enter 
Python commands. You can also import the hou module into 
a regular Python shell to integrate Houdini into your existing 
Python-based scripts.

TOOL SHELVES
The shelf tools are also set up using Python. You can see this 
code by RMB-clicking on any shelf tool and choosing Edit Tool.

PYSIDE/PYQT
The Python Panel Editor pane lets you create, edit and delete 
PySide2 or PyQt5 interfaces. The editor also lets you manage 
the entries in the Python Panel interfaces menu as well as the 
entries in the Houdini pane tab menu. The panel comes with 
some sample code that you can try out for yourself.

PYTHON STATES
You can also write viewer states in Python that let you 
customize user interaction in the viewport for your node. You 
can use these to build more artist friendly interfaces for tools 
and you can refer to the documentation for more detailed info.
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 VEX
VEX is a high-performance expression language used in many 
places in Houdini, such as writing shaders. VEX evaluation is 
typically very efficient, giving performance close to compiled 
C/C++ code. 
VEX is not an alternative to scripting, but rather a smaller, 
more efficient general purpose language for writing shaders 
and custom nodes. VEX is loosely based on the C language, 
but takes ideas from C++ as well as the RenderMan shading 
language.
VEX is used in several places in Houdini:
Modeling – The VEX SOP allows you to write a custom surface node 
that manipulates point attributes. This can move points around, adjust 
velocities, change colors. As well, you can group points or do many 
other useful tasks.

Rendering – Karma and Mantra use VEX for shading computation. This 
includes light, surface, displacement and fog shaders.

Compositing – The VEX Generator and VEX Filter COPs allows you 
to write complex custom COPs in VEX. The expressions evaluate very 
close to C/C++ speeds and run 1000’s of times faster than the Pixel 
Expression COP.

CHOPs – The VEX CHOP lets you create custom CHOPs. The CHOP 
functions can manipulate arbitrary numbers of input channels and 
process channel data in arbitrary ways. In some cases, the VEX code 
can run faster than compiled C++ code.

Fur – Procedural fur behavior is implemented with VEX.

VOPS
If you want to use VEX but don’t want to write the code then 
you can use the VOP context to use a node-based interface. 
You can do this in the SOP context using an Attribute VOP 
node that lets you dive in and use VOPs to create VEX code. 
You can take input geometry and manipulate it.

You can use parameter vops to build interface element such as 
float sliders that are then available at the SOP level. This way 
you can execute the VEX code without diving back down to 
the VOP level. 

The VOPs context is designed to give artists an interactive way 
of creating VEX code. For people with a scripting background, 
it might make more sense to write the code directly into a 
Wrangle node.

WRANGLE NODES
You can also use a wrangle node such as the Attribute Wrangle 
which provides a low-level node that lets coders who are 
familiar with VEX tweak attributes. There are also wrangle 
nodes for working with channels, volumes and deformations. 

If you are interested in learning how to work with wrangle 
nodes, you should take a look at Entagma.com where you will 
find lots of great tutorials that generally take a more technical 
approach to creating content but with an artist’s mindset. 

COMPILE BLOCKS
In geometry networks [SOPs], you can put a part of the 
network inside a compiled block that makes it function as 
efficiently as if you had written code. This imposes a number of 
restrictions on how the network can work, but can potentially 
deliver big benefits in the right circumstances.

HOUDINI DEVELOPERS KIT | HDK
An even deeper way to work with Houdini is to use the 
HDK which is the same comprehensive set of C++ libraries 
that SideFX programmers use to develop the Houdini family 
of products. With the HDK, you can create plug-ins which 
customize different areas in the Houdini interface. Here are 
some examples of what you can do with the development kit:

	� Add custom expression functions
	� Add custom commands (hscript or HOM)
	� Add custom operators (SOPs, COPs, DOPs, VOPs, ROPs, CHOPs, 

and even Objects)
	� Add output nodes to support a non-standard Renderer
	� Add custom lighting or atmospheric effects to the renderer

To learn more about working with the HDK, go to the SideFX 
website and choose Support > Documentation > HDK.
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Tasks
With the Task Operators or TOPs, you can organize and schedule tasks then distribute them 
intelligently to your compute farm. This allows for parallel processing of data while maintaining a 
dependency graph that shows how each task relates to proceeding tasks. 

PROCEDURAL DEPENDENCY GRAPH
TOPs is a network type in Houdini built using the Procedural 
Dependency Graph, a technology which makes it possible 
to describe complex dependencies visually with nodes, then 
generate a set of actionable tasks which can be distributed 
to a compute farm with the help of a scheduler. Once you 
evaluate the results, it is possible to make changes to parts of 
the graph without re-cooking the whole network.

TOP NODES
Task or TOP nodes let you manage pipeline tasks with the 
ultimate goal of parallelizing the processing and distribution 
of each task. As a TOP node generates a task, the task is 
displayed as a dot. Once the task is cooked then new tasks can 
be executed on this node and on children TOP nodes.

SCHEDULERS
Scheduler nodes take tasks that have met required 
dependencies and assigns compute resources. As each task is 
completed, the scheduler informs the task graph, which in turn 
informs the PDG graph to move on to the next available task. 
PDG supports industry-standard schedulers such as HQueue, 
Deadline, Tractor, or any scheduler plugged in with Python.

COOKING TOP NODES
Once you wire together a task graph, you will want to cook the 
nodes. You can either cook a node in the middle of the graph 
or cook the output node at the end of the chain.

	� Cook Selected Node	 Shift-G
	� Dirty and Cook Selected Node	 Shift-V

Use the Task Bar to monitor your progress. On the TOP nodes, 
you can RMB-click on a task dot and choose to Cook or Dirty 
the task. When you dirty a task, it means that if you recook the 
network those tasks will be recomputed. Clean tasks will not 
be recooked which is one of the benefits of TOPs because you 
don’t have to redo work that is already completed.

DEPENDENCIES
When you click on a task dot in the graph, you will see a thin 
line that connects to upstream tasks it is dependent on and 
downstream tasks that depend on it. 
If there are changes upstream then tasks may be automatically 
dirtied and this will in turn dirty tasks downstream where there 
are dependencies. This process is an important part of how 
PDG graphs work as an effective pipeline tool.

TOP NODE
Input - The node takes the information feeding 
into the Input and breaks it into one task for 
every piece of data.

Progress Wheel - The progress wheel shows 
you how many tasks are completed, how many 
are in progress and how many are in the queue.

TOP Node - This is the node that is currently 
being cooked. It contains the instructions for 
the tasks being executed. You can RMB-click on 
the node for a menu of supporting actions.

Tasks - Each task is represented by a small dot. 
The coloring indicates their current status and 
you can RMB-click on a task dot to learn more 
about that one part of the graph. 

Output - Once tasks are completed, the output 
passes the results on to the next node even if 
other tasks on this node are still active.

RMB on Node....
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TASK GRAPH TABLE
If you RMB-click on a node, you can choose to Open Task 
Graph Table. This gives you an itemized list of tasks along 
with information such as index, state, cook time and priority. 
Clicking on items in this window will highlight the task dot on 
the node in the Network view.

IMPORT/EXPORT DATA
To get data into the TOP graph, there are a number of different 
options giving you access to geometry, images, scripts and 
other kinds of data. Houdini Digital Assets can be used to apply 
procedural networks or you can connect with other parts of 
Houdini to import and export data.

WEDGE NODE
A key workflow in PDG is wedging that lets you quickly create 
multiple iterations of a design. You can then process all of the 
different options through the TOP graph then collect them at 
the end for final output. 

OUTPUT IMAGE MOSAICS AND MOVIES
In TOPS, you can interface with ImageMagik to create a 
contact sheet that can be used to evaluate design iterations to 
make the best choice or to generate prop variations to richly 
populate your scene. You can use an overlay to pull info from 
the network to help you make the best decision.

INTEGRATIONS WITH OTHER APPS
TOPs includes nodes for working with other applications such 
as Shotgun or Autodesk Maya. This allows your network to 
extend beyond Houdini to help with all parts of the pipeline.

PILOT PDG APPLICATION
While TOP networks can be set up and executed from within 
Houdini, wranglers who are managing the farm or pipeline TDs 
who are exclusively creating TOP networks can use PilotPDG. 
Tasks that are Houdini-related will call on Houdini Engine to 
work non-graphically to complete the task.

TOP NETWORK
This network type lets you 
manage and view the network 
being processed.

Task Bar- The task bar lets you 
start and stop a network and 
monitor its progress.

Scheduler- The scheduler node  
determines where your data is 
being processed and how many 
nodes are participating.

Completed Tasks - When a node 
is finished processing all its tasks, 
a check mark appears.

In Progress Tasks - While in 
progress, you can see which 
tasks still need to be completed.

Network Path- This shows you 
the path to the TOP network 
where the graph is set up.

TOP Menu- This menu 
includes a range of options for 
organizing and processing a 
TOP network.

Progress Bar - This bar lets you 
see the progress of the overall 
network tasks.

TOP nodes - These nodes are 
where specific commands are 
turned into tasks and sent by 
the scheduler to be completed.

Dependency Line - You can 
click on a task to see how it 
connects to other tasks in the 
network.
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.hda file

One of the things that Houdini’s node-based workflow is great 
at is allowing artists to avoid repetitive steps and to generate 
multiple iterations by making changes to an existing network 
of nodes. This lets you achieve results that are unique without 
starting the whole process from scratch. 
Houdini Digital Assets take this one step further by letting you 
encapsulate a network or collection of networks into a single 
node with parameters that have been promoted to the top 
level. This node is then saved to disk which creates a shareable 
file that other artists can load into their scenes.

ARTIST BUILT TOOLS
The process of creating a Houdini Digital Asset works with the 
interactive tools in Houdini. You build a high level interface by 
dragging parameters from nodes to an asset properties panel 
which allows you to create custom tools without writing any 
code. This means that technical artists can build custom tools 
then deploy them quickly to colleagues. 
A Houdini Digital Asset might be a procedural prop such as 
a staircase or a piece of furniture, a visual effect such as an 
explosion, or a more generalized tool such as a populate tool 
for scattering objects over a surface. Whether you are creating 
content specifically for your current project or building a larger 
toolset for all your projects, your artists can build a collection 
of Houdini Digital Assets to meet your production needs. 

PIPELINE FRIENDLY
When a Houdini Digital Asset is loaded into a scene file, it 
references the .hda file on disk. This means that changes made 
to the asset will be picked up automatically by everyone who 
is referencing that file. 
This makes it very easy to deploy updates throughout your 
pipeline. Now artists can point to a single asset on disk 
knowing that once it gets updated with the most current 
iteration, they will immediately have access.
Houdini Digital Asset files can also hold more than just the asset 
definition. You can store images, geometry files and scripts that 
are used by the asset. This ensures that all the relevant parts are 
available when other people work with the asset.

CONTENT LIBRARY & ORBOLT
The Content Library is an online asset repository which hosts 
2D and 3D assets, from complete scene files, to fully-rigged 
props, to render-ready visual effects, animatable characters, 
game assets and more. Go to Get > Content Library on the 
SideFX website to access it. 
Orbolt an online asset marketplace that offers a wide variety 
of digital assets. There is a panel in Houdini where Orbolt 
assets you download or purchase can be stored and made 
available as you work.

HOUDINI DIGITAL ASSETS 
Procedural Tool Building
Networks of nodes give Houdini its procedural nature and define a recipe that can be applied over 
and over. Houdini Digital Assets let you wrap up these networks to create custom tools and smart 
assets. These artist-built tools can be used repeatedly to increase productivity across your studio.

CREATING DIGITAL ASSETS

Houdini

SAVE AS

Houdini
Digital 
Asset

1  Create nodes and  
networks in Houdini

2  Package up the networks to be saved 
out as a Houdini Digital Asset [.hda]  
file that can be shared with other artists.

4  Load the .hda file back into 
Houdini to use the asset. 

Only those parameters promoted 
to the asset level can be used. All 
others are locked.

You can use the asset in any num-
ber of Houdini scenes. If you make 
changes to the HDA file then all 
other assets can be easily synced to 
the changes.3  Build an interface for your asset by 

promoting parameters and handles 
to the top level of the asset. 
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The benefits of Houdini Digital Assets can be 
experienced by artists using other applications 
thanks to the Houdini Engine plug-ins. Created with 
the Houdini Engine API, these plug-ins allow host 
applications to load .hda files and all of the handles 
and controls. When parameters are set on the asset, 
Houdini works “under-the-hood” to cook the nodes 
and networks then deliver the results back to the host.

HOUDINI ENGINE API
This is made possible by the Houdini API which is 
used to create plug-ins for host applications. HAPI 
is a flat and small API that is easy to learn and is 
available on github for developers that want to 
create their own proprietary plug-in.

HOUDINI ENGINE PLUG-INS
There are a number of Houdini Engine plug-ins that artists can 
access either through the Houdini installer or online. These 
have been production tested and can be used confidently by 
artists and studios.
Each of the plug-ins are designed to create a bridge between 
the features in a typical Houdini asset and the nature of the 
host application. For instance a cloud asset that use volumes 
would work fine in Maya but would not make sense in Unity or 
Unreal where volumes are not supported.

Plug-ins that work with FREE Houdini Engine for Unity/Unreal 
or FREE Houdini Engine Indie licenses:

	� Unreal
	� Unity

Plug-ins that work with Houdini Engine licenses or FREE 
Houdini Engine Indie licenses:

	� Autodesk Maya
	� Autodesk 3DS Max 
	� Proprietary Plug-ins

HOUDINI ENGINE
Sharing with other Apps
Houdini Engine brings a procedural node-based approach to your favorite app. This technology lets 
you share Houdini Digital Assets with colleagues who can load them directly into 3D apps such as 
Autodesk® Maya® or 3DS MAX® or into game editors such as Unity® or Unreal..®

HOUDINI ENGINE PIPELINE

A Houdini Digital Asset loaded into Autodesk Maya using the Houdini Engine

Houdini
Engine

Host App

Houdini
Libraries

LOAD

Houdini
Digital 
Asset

.hda file1  Load the .hda file into a host  
application using the Houdini  
Engine plug-in.

3  The Houdini Engine calls  
on the Houdini library files  
to “cook” the nodes and  
network inside the asset. 

4  When an asset is loaded or a 
parameter is changed then the  
Engine grabs the Houdini libraries, 
cooks the nodes, then delivers the 
results back to the Host. 

2  The Host Application  
accepts the asset and interfaces 
with the Houdini Engine.

Host applications with  
Houdini Engine plug-ins
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Houdini is a full featured package that contributes to all stages of 
a Film & TV pipeline. From modeling to rendering to animation 
and final compositing, Houdini has procedural tools that support 
your creative process. Over the years, VFX is one area where 
Houdini is known as an industry standard. SideFX has been 
honored with several Scientific and Technical Achievement 
awards including an ACADEMY AWARD OF MERIT Oscar.
Other areas such as procedural modeling, lighting or character 
work continue to get stronger to the point where a growing 
request from studios is more skilled Houdini artists.

HOUDINI CORE / HOUDINI FX
There are two commercial versions of Houdini that you use 
in your pipeline. Houdini Core covers all of Houdini’s tools 
except for DOPS, and Houdini FX has a full toolset. Scenes 
and VFX created in Houdini FX can be staged, animated, lit 
and rendered in Houdini Core. This gives you a robust pipeline 
with Houdini FX licenses for your FX artists and Houdini Core 
licenses for everyone else. 
One solution is for senior technical directors to use Houdini 
FX to solve a particular production challenge then wrap up 
the resulting nodes and networks into Houdini Digital Assets. 
An artist-friendly UI is then built to support the animators and 
VFX artists who can then use the more cost effective Houdini 
Core to execute shots. 

INTEROPERABILITY
Most studios are equipped with a variety of 3D applications to 
each handle a different part of the pipeline. Houdini has a lot 
of strong interoperability tools to allow for this interchange of 
data. Whether they are using USD, Alembic, FBX or EXR, your 
artists can easily work back and forth with a wide variety of DCC 
applications. They can also use the Houdini Engine plug-ins to 
bring the Houdini Digital Assets into other applications, such as 
Autodesk® Maya® or 3DS MAX,® while maintaining the asset’s 
procedural controls.
Smaller studios may want to avoid extensive file exchange, 
especially with tight deadlines, therefore Houdini provides a 
full featured procedural “pipeline-in-a-box” that can take you 
through all of the stages under one roof. 

DISTRIBUTED RENDERS AND SIMS
Rendering images and simulating VFX can be time consuming, 
especially as you aspire towards photorealistic results. For this 
reason, Houdini lets you distribute both rendering and simulation 
tasks to a compute farm using Houdini Engine in Batch mode.
Distributed simulations allow you to work faster or to handle 
effects that would max out the memory on any one computer. 
By slicing the sim and distributing it, memory is managed 
without compromising the final result. Studios should definitely 
consider using Houdini Engine to simulate on the farm.

FILM & TV PIPELINE
Animation and VFX
Whether you are creating live action plates enhanced with visual effects or full CG shots, the 
ultimate goal of Film and TV projects is moving pictures. These pictures are created using assets 
such as characters, sets and effects which all come together in a final composition.

FILM & TV PIPELINE

Render
 VFX

 Layout Animate Light Render Composite

Lighting
 VFX

Simulate
 VFX

Animate
 VFX

 

 

 

Distribute
Sims

Distribute
Render

Distribute
Render

Particles and 
Dynamics

RigModel

Houdini FX

Houdini CORE
Karma Render/Mantra

Houdini Engine

USD, FBX, OBJ, EXR etc...

File Transfer
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At the core of a games pipeline is a game engine 
like Unreal or Unity. The engine is where the game 
art and the game interactions are put together to 
create a playable experience. Houdini can be used by 
game artists to create terrain, design and populate 
levels, build procedural models, build and animate 
characters and create Realtime FX such as fire, fluids 
and destruction.

EXPORTING TO GAME ENGINES
There are two ways of getting content from Houdini 
to a game engine. The traditional approach is to 
export out to a format like FBX or OBJ and import 
this into the engine. You would create procedural 
systems in Houdini then flatten out the results.
The second approach is to create Houdini Digital 
Assets and load these into the game engines using the Houdini 
Engine plug-ins for Unreal and Unity. These assets import into 
the game editor with their parameters and controls intact. You 
can therefore make changes inside the game editor and the 
Houdini Engine works in the background to update the artwork.
This proceduralism is available to game artists inside the editor 
then when the game is compiled the artwork is baked down. 
The Houdini Engine is not a runtime solution and you cannot 
access it as part of the gameplay. 

REALTIME FX
Houdini is known for VFX and it is a great tool for creating 
FX for games. But these FX need to be optimized using 
techniques such as texture sheets, flowmaps and vertex 
animation textures. This way the footprint for the effect is as 
light as possible and does not take away from the frames per 
second of the game. The SideFX Labs Tools mentioned earlier 
in this document have been designed to support these kinds 
of workflows.

GAMEDEV & VR PIPELINE
Interactive Experiences
In Video Game and Virtual Reality projects, the main focus is creating interactive 3D worlds built 
using content that is highly optimized for a smooth gameplay experience. This creates a different 
kind of pipeline compared to rendered out game cinematics which are more like film. 

GAMEDEV & VR PIPELINE

Houdini Digital Assets loaded into Unreal using the Houdini Engine

Houdini FX

Houdini CORE
Game Engines/Other Apps

Houdini Engine Plug-ins

FBX, OBJ, USD, EXR etc...

File Transfer
Maya/

3DS Max

AnimateRigModel

 

Procedural
Modeling

Level 
Design

Export

Game
Engine

Realtime FX

Play Game

Compile/
Bake Assets

Save as
HDA

 

Terrain
Generation

Populate
Environment
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As you begin working with Houdini, it is useful to understand 
what Houdini products are available for you to work with. 
Whether you are a large studio, small studio or a team of indies 
just getting started, there are different Houdini products to 
suit your needs. There are also versions of Houdini for school 
labs and for students who want to learn for free. 

COMMERCIAL LICENSES 
Houdini Core – Designed for modelers, lighters, character 
riggers, animators and game artists, Houdini Core also includes 
features such as compositing and motion editing. Scenes 
created in Houdini FX can be opened and rendered in Houdini 
Core which makes it an ideal lighting tool for your VFX.
Houdini FX – Houdini FX has all the tools found in Houdini 
Core but adds particle and dynamic simulation tools. With its 
procedural workflow, Houdini FX lets you create fluids, Pyro 
FX, grains, cloth, hair & fur, crowds and soft body effects.
Houdini Engine – Houdini Engine gives you command-line 
access to run in batch mode to batch process renderings and 
distributed dynamic simulations. Houdini Engine also lets you 
load Houdini Digital Assets into other digital content creation 
applications, such as Autodesk® Maya,® Autodesk® 3DS MAX,® 
Unity® or Unreal.®

INDIE LICENSES
Houdini Indie – Houdini Indie makes all of Houdini’s animation 
and VFX tools available under a limited commercial [less than 
$100K USD] license to animators and game makers who want 
to use Houdini during the incubation stage of their business. 
Houdini Engine Indie – Your Houdini Engine Indie license can 
be used to run Houdini Indie in batch mode or to load Houdini 
Digital Assets into other content creation apps.

LEARNING LICENSES
Houdini Education – Houdini Education is a full-featured version 
of Houdini FX designed for use by schools and training centres. 
Designed to be used in labs and classrooms, Houdini Education 
will open files created by students using Houdini Apprentice.
Houdini Apprentice – Houdini Apprentice is a free version 
of Houdini FX which can be used by students, artists and 
hobbyists to create personal non-commercial projects. With 
Houdini Apprentice, you have access to virtually all of the 
features of the award-winning Houdini FX to develop your 
skills and work on personal projects. Apprentice lets you save 
to disk and render out with a word mark.

If a student wants to work without the word mark and they 
don’t have access to Houdini Education at their school then we 
recommend working with Houdini Indie.

Note: Scene files and Assets created in Indie, Apprentice or 
Education cannot be used in commercial Houdini. The file formats 
are different and the EULA [End User License Agreement] prevents 
you from sharing files between different license types.

LICENSE TYPES
Workstation [Node-Locked] – This license type can be used 
on a single computer and can only be accessed either from a 
local server or from SideFX.com.
Local/Global Access [Floating] – These licenses can be set up 
on a server and shared with a team of artists. When an artist 
starts Houdini a license is checked out of the server as long as 
there is one available. Local licenses are designed for a single 
studio and global licenses are for sharing between studios in 
different locations.

INSTALLING LICENSES
Once you have acquired a license, you will install it by opening 
up the Houdini License Administrator [hkey] application. From 
there you can choose File > Install Licenses. You will be asked 
for a log in and a password that will match the ones you set up 
on the SideFX.com website. 
You can now use sidefx.com as the license server instead 
of installing locally. To use Login licensing, you need to be 
constantly logged in with your sidefx account. You can login 
using different computers but only one of them can be used at 
a time. This approach is ideal for Indie and Education users. 
Local and Global Access licenses can be installed using this 
method on a central server. You will then need to make that 
server available to anyone who needs access to the licenses. 
You can also view your licenses on the SideFX.com website by 
clicking on your avatar in the top right and choosing Services. 
You can then click on the Manage Licenses link.

ANNUAL UPGRADE PLAN
For visual effects studios, games studios and 3D artists who 
want to maximize their investment in Houdini, the Annual 
Upgrade Plan provides key advantages such as production-
level technical support and access to full and dot releases 
containing the latest software enhancements as well as daily 
builds containing bug fixes. 

SIDEFX SUPPORT
All customers including Apprentice customers can contact 
SideFX using our email support system to discuss installation 
and licensing issues. After that, only Annual Upgrade Plan and 
Commercial Rental Customers may contact our support team 
to discuss more in depth production issues.
Our Support Specialists can be contacted directly via  
support@sidefx.com . Be sure to include the following  
information in your email:
	� Your Operating system [Windows XP, etc.]
	� Version and Build Number of Houdini
	� Summary of the installation issue and a diagnostic file if you are 

having a licensing issue.
To learn about support programs visit SideFX.com/support.

Products & Licensing
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Comparison Chart 
COMMERCIAL INDIE LEARNING

PRODUCT HOUDINI FX HOUDINI CORE HOUDINI INDIE EDUCATION APPRENTICE

INTENDED USER Studios | Commercial Artists Indies | Freelancers Schools Students | Hobbyists

PRICING Visit SideFX.com $269 USD per year $75 USD per year FREE

Operating System Windows, LINUX, Mac OSX

Modeling     

Character     

Animation     

Solaris: Layout Tools     

Solaris: Lookdev and Lighting     

Karma/Mantra Rendering     

Terrain     

Compositing     

Volumes     

Pyro FX  Simple Fireball   

Fluids  Simple Flip   

Rigid Bodies  Simple Fracture   

Particles  -   

Vellum Cloth  Simple Cloth   

Wire Dynamics  -   

Crowds  -   

LICENSING Commercial Limited Commercial Non-Commercial

Workstation [Node-Locked]    - 

Local/Global Access [Floating]   -  -

USER INTERFACE

Houdini GUI Access     

Command Line Access     

GUI Watermark - - Unobtrusive Unobtrusive Unobtrusive

Plug-in Support     

HOUDINI ENGINE

Houdini Engine Plug-ins     No

Create Assets for Engine     For Education Licenses

Create Assets for Orbolt     

RENDERING

Karma Tokens 5  / 10* 5 / 10* 1 10 1

Mantra Tokens Unlimited Unlimited 1 10 1

3rd Party Rendering     No

Render Watermark - - - - 

Resolution Unlimited Unlimited Unlimited Unlimited 1280x720

SCENE

.hip   .hipalc .hipanc .hipanc

.hda   .hdalc .hdanc .hdanc

GEOMETRY

USD     .usdnc

FBX     IMPORT

Alembic     IMPORT

.bgeo     

IMAGES

.pic   .piclc  .picnc

.exr     watermarked

.tif     watermarked

.png/,jpg     watermarked
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* Commercial Workstation Licenses come with 5 Karma Tokens and Local and Global Access Licenses come with 10 Karma tokens
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  SCENE VIEW SHORTCUTS

  NETWORK VIEW SHORTCUTS

TOOLS

	Select	 S
	 Move	 T�	
	 Rotate	 R	
	Scale	 E�	
	Pose	 Ctrl-R�	
	Handle 	 Enter�	
	View	 Esc�

Tool Menu	 Tab�
Custom Radial Menu	 C
Repeat Last Tool	 G

VIEW 

	Tumble	 Space/Alt + LMB
	Track	 Space/Alt + MMB
	Dolly	 Space/Alt + RMB

Home Grid	 Space + H
Home All	 Space + A
Home Selected	 Space + G

VIEW RADIAL MENU

Selection Tools	 V �
Selection Options	 V �
Viewport	 V �
Shading	 V 

SELECTION MODES

	Objects	 1� 	
	Points	 2�	
	Edges	 3�	
	Primitives (Faces)	 4�	
	Vertices	 5�

Select Groups/Connected Geometry	 9�
Toggle Objects/Geometry	 F8

SELECTING

Select	 LMB
Add to Selection	 Shift + LMB
Remove from Selection	 Ctrl + LMB
Toggle Selection	 Ctrl + Shift + LMB

Select All	 N
Select Nothing	 Shift-N

SNAPPING RADIAL MENU

	Grid Snap	 X �	
	Primitive (Curve) Snap	 X �	
	Point Snap	 X �	
	Multi-Snapping Snap	 X 

VIEWPORTS

Expand Viewport	 Space + b
Select Viewport	 Space + n
Perspective View	 Space + 1
Top View	 Space + 2
Front View	 Space + 3
Right View	 Space + 4
UV View	 Space + 5

Toggle Wireframe/Shaded	 W
Display Options	 D

VIEWPORT LAYOUT

Single View	 Ctrl + 1
Four Views	 Ctrl + 2
Two Views Stacked	 Ctrl + 3
Two Views Side by Side	 Ctrl + 4
Three Views Split Bottom	 Ctrl + 5
Three Views Split Left	 Ctrl + 6
Four Views Split Bottom	 Ctrl + 7
Four Views Split Left	 Ctrl + 8

FINDING THINGS

Dashbox	 Ctrl + D

VIEW 

Pan  	 Space + LMB or MMB�
Zoom	 Space + RMB or Scroll Wheel�
Show all Nodes	 H
Show Selected Nodes	 G

CREATE 

Node Menu	 Tab�
Add File Node	 =�
Create Subnet	 Shift + C
Add Background Image	 Shift - I

NOTES AND NETWORK BOXES

Add Network Box	 Shift + O
Add Sticky	 Shift - P
Minimize Selected Notes/Boxes	 Shift - J
Expand Selected Notes/Boxes	 Shift - K
Shrink box to fit contents	 Shift - M

WIRING

Connect Nodes	 LMB on Connector
Connect Multiple Nodes	 J drag over nodes �
Insert Node	 RMB on Connector�
Branch 	 MMB on Connector
Connector List 	 Alt + MMB on Node�
Cut Wire	 Y drag across wire
Disconnect from Wires	 Shake Node

DOTS

Add Dot	 Alt + LMB on wire�
Pin/Unpin Dot	 Alt + LMB on dot

TOOLS

Toggle Parameter Pane	 P
Toggle Tree View	 Shift + W
Toggle Network Overview	 O
Toggle Color Palette	 C
oggle Shape Palette	 S

CLICKS AND DRAGS

Select	 LMB�
Add to Selection	 Shift + LMB�
Remove from Selection	 Ctrl + LMB
Start Wiring from Node	 Alt + LMB
Select Node + Inputs	 Alt + Shift + LMB
Select Node + Output	 Alt + Ctrl + LMB
Select Inputs + Outputs	 Alt + Shift + Ctrl  + LMB
Move Node	 LMB-Drag�
Move Node + Inputs	 Shift + LMB-Drag�
Move Node + Outputs	 Ctrl + LMB-Drag
Copy Selected Nodes	 Alt + LMB-Drag 
Copy Node + Inputs	 Alt + Shift + LMB-Drag
Copy Node + Output	 Alt + Ctrl + LMB-Drag
Reference Copy	 Alt + Shift + Ctrl + LMB-Drag

NAVIGATION

Enter a Node	 Double-click or Enter�
Go up a level	 U
Radial Menu	 N
Create a Quickmark	 Ctrl + <# 1-5>
Go to a Quickmark	 Shift + <# 1-5>
Go to Previous View	 ` (Backtick)
Select the Node Upstream	 PgUp
Select the Node Downstream	 PgDn
Select Previous Sibling 	 Shift + PgUp
Select Next Sibling 	 Shift + PgDn

ORGANIZE NODES

Layout all	 L
�Align	 A + LMB-Drag Down/Across 

DISPLAY FLAGS | SOP LEVEL

Render	 T + LMB�
Display	 R + LMB
Template	 E + LMB�
Footprint	 W + LMB
Bypass	 G or B + LMB


